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PART I

A Tour of the GNOME Desktop

This section introduces the core GNOME components. This section also provides
information that helps you to start working with the desktop. The desktop is very
configurable, therefore this section covers the main functional possibilities of the
desktop features. If you want to find out how to implement the various configuration
possibilities that are mentioned in this section, see Customizing Your GNOME Desktop.
The chapters in this section are as follows:

®  Basic Skills

Read this chapter to find out about mouse usage, shortcut keys, basic window
skills, and basic dialog skills.

®  Qverview of the Desktop

Read this chapter for an introduction to the major components and functions of the
desktop. If you do not read anything else in this manual, read this chapter.

m  Desktop Sessions

Read this chapter for information about how to start, manage, and end desktop
sessions.

m  Working With Panels

Read this chapter to find out more about using panels. Panels are a key component
of the desktop. This chapter tells you how to use the different parts of your panels,
and how to invoke the available functions of the desktop using panels.

m  Working With Menus
Read this chapter to find out more about using menus.
m Working With Windows

Read this chapter to find out more about using windows. This chapter describes
basic windows functions such as moving and resizing. This chapter also describes
the controls that you use with windows.

®  Nautilus File Manager
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Read this chapter to find out more about the Nautilus file manager. This chapter
describes how to use Nautilus to work with your file system. This chapter also
describes how to customize Nautilus.

m  Using the Desktop Background

Read this chapter to find out more about using the desktop background. This
chapter describes how to use the desktop background to start applications, and
open your files and folders. The chapter also describes how to use Trash from the
desktop, how to use the Desktop Background menu, and how to customize the
desktop background.

16 GNOME 2.2 Desktop User Guide * January 24, 2003



CHAPTER 1

Basic Skills

This chapter introduces you to the basic skills that you need to work with your
desktop.

m  “Mouse Skills” on page 17
m  “Keyboard Skills” on page 21
m  “Using Windows and Dialogs” on page 25

Mouse Skills

Even if you are very familiar with mouse devices, you should still familiarize yourself
with the button conventions and action terminology used in this manual. This section
also describes the mouse pointers.

Mouse Button Conventions

All the instructions in this manual are for the following types of mouse devices:

®  Devices that are configured for right-hand users.

m  Three button devices. If you have a two-button mouse device, then you press the
two buttons simultaneously to simulate the effect of a middle mouse button.

The mouse button conventions used in this manual are as follows:
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Mouse Button Definition

Left mouse button The button on the left side of a mouse device configured
for normal right-hand use.

Middle mouse button The middle button of a mouse device configured for
normal right-hand use.

Right mouse button The button on the right side of a mouse device configured
for normal right-hand use.

To reverse the handedness of your mouse device, choose Applications — Desktop
Preferences — Mouse, then select the options that you require. If you do reverse the
handedness of your mouse device, then you must reverse the mouse button
conventions used in this manual.

Mouse Actions

The following table describes the actions that you can perform with the mouse:

Mouse Button Definition

Left mouse button Use to perform the following actions:
B Select text.
B Choose items.
®  Drag items.

Middle mouse button Use to perform the following actions:
®  Paste text.
®  Move items.

Right mouse button Opens a menu for the selected object, if a menu applies.

For example, if you want to copy text then perform the following steps:

1. Select the text with the left mouse button.
2. Move the mouse pointer to the location where you want to copy the text.
3. Click on the middle mouse button.

You can also right-click on the desktop background to open the Desktop Background
menu.
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Mouse Action Terminology

The conventions used in this manual to describe actions that you take with the mouse

are as follows:

Action

Definition

Click

Click-and-hold
Left-click

Middle-click

Right-click

Double-click

Drag

Drag-and-drop

Grab

Press and release the left mouse button, without moving
the mouse.

Press and do not release the left mouse button.

Same as click. Left-click clarifies the action when there
might be confusion with right-click.

Press and release the middle mouse button, without
moving the mouse.

Press and release the right mouse button, without moving
the mouse.

Press and release the left mouse button twice in rapid
succession without moving the mouse.

Click-and-hold a mouse button, then move an object. For
example, you can drag a window or an icon. The left and
middle mouse buttons can perform drag actions.

Click-and-hold a mouse button, then move an object. For
example, you can drag-and-drop a window or an icon.
Release the mouse button to place the object in a new
location.

Point to an item that you can move, and click-and-hold on
the mouse button. For example, you can grab the titlebar of
a window, then drag the window to a new location.

Mouse Pointers

As you use the mouse, the appearance of the mouse pointer can change. The
appearance of the pointer can provide feedback about a particular operation, location,
or state. The following table lists and describes some of the mouse pointers.
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Pointer

Associated Action

Description

7

I«

I

Point to an item, choose a menu

item

Drag-and-drop

Drag-and-drop

Drag-and-drop

Drag-and-drop

Drag-and-drop

Move panel object

Resize window horizontally

Resize window vertically

Resize window horizontally and
vertically

Normal pointer. The pointer that
appears during normal use of the
mouse.

Move pointer. Indicates that when
you drop the object, the object is
moved from the old location to the
new location.

Copy pointer. Indicates that when
you drop the object, a copy of the
object is created where you drop
the object.

Link pointer. Indicates that when
you drop the object, a link to the

object is created where you drop

the object.

Ask pointer. Indicates that when
you drop the object, a menu opens.
You can choose to move or copy
the object, or to create a link to the
object.

Not available pointer. Indicates that
you cannot drop the object at the
current location.

Move panel object pointer.
Indicates that you have selected a
panel object to move.

Horizontal resize pointer. Indicates
that you have selected a vertical
window border to resize the
window horizontally.

Vertical resize pointer. Indicates
that you have selected a horizontal
window border to resize the
window vertically.

Corner resize pointer. Indicates that
you have selected a corner of a
window border to resize the
window horizontally and vertically.
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Pointer Associated Action Description

Resize window pane or resize table Window pane or table column

column resize pointer. Indicates that you
have selected a column in a table to
resize.

Keyboard Skills

For almost every task that you can perform with the mouse, you can use the keyboard
to perform the same task. Shortcut keys are keys that provide you with a quick way to
perform a task.

You can use shortcut keys to perform desktop tasks and to work with interface items
such as panels and windows. You can also use shortcut keys in applications. To
customize your shortcut keys, choose Applications — Desktop Preferences —
Keyboard Shortcuts.

You can also modify your desktop preferences to use keyboard accessibility features.

The following sections describe the shortcut keys that you can use.

Desktop Shortcut Keys

Desktop shortcut keys enable you to use the keyboard to perform desktop tasks. The
following table lists some desktop shortcut keys:

Default Shortcut Keys Function

Alt + F1 Opens the GNOME Menu.

Alt + F2 Displays the Run Program dialog.

Print Screen Takes a screenshot.

Alt + Print Screen Takes a screenshot of the window that has focus.

Ctrl + Alt + right arrow Switches to the workspace to the right of the current
workspace.

Ctrl + Alt + left arrow Switches to the workspace to the left of the current
workspace.
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Default Shortcut Keys

Function

Ctrl + Alt + up arrow
Ctrl + Alt + down arrow

Ctrl + Alt +d

F1

Switches to the workspace above the current workspace.
Switches to the workspace below the current workspace.

Minimizes all windows, and gives focus to the desktop
background.

Starts the online help browser, and displays appropriate
online help.

Window Shortcut Keys

Window shortcut keys enable you to use the keyboard to perform window tasks. The

following table lists some window shortcut keys:

Default Shortcut Keys

Function

Alt + Tab

Alt + Esc

F10

Alt + spacebar
Arrow keys
Return

Esc

Ctrl + Alt + right arrow

Ctrl + Alt + left arrow

Ctrl + Alt + up arrow
Ctrl + Alt + down arrow

Ctrl + Alt +d

Switches between windows. Release the keys to select a
window.

Switches between windows in reverse order. Release the
keys to select a window.

Opents the first menu on the left side of the menubar.
Opens the Window Menu.

Moves the focus between items in a menu.

Chooses a menu item.

Closes an open menu.

Switches to the workspace to the right of the current
workspace.

Switches to the workspace to the left of the current
workspace.

Switches to the workspace above the current workspace.
Switches to the workspace below the current workspace.

Minimizes all windows, and gives focus to the desktop
background.
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Panel Shortcut Keys

Panel shortcut keys enable you to use the keyboard to perform panel tasks. The
following table lists panel shortcut keys:

Default Shortcut Keys

Function

Ctrl + Alt + Tab

Ctrl + F10
Tab
Return
Shift + F10

Arrow keys

Esc
F10

Switches the focus between the panels and the desktop
background.

Opens the popup menu for the selected panel.
Switches the focus between objects on a panel.
Chooses the selected panel object or menu item.
Opens the popup menu for the selected panel object.

Moves the focus between items in a menu. Moves the focus
between interface items in an applet also.

Closes an open menu.

Opens the Applications menu on the Menu Panel, if the Menu
Panel is selected.

Application Shortcut Keys

Application shortcut keys enable you to perform application tasks. You can use
shortcut keys to perform application tasks more quickly than if you use a mouse. The
following table lists some application shortcut keys:

Shortcut Keys Command
Ctrl + N New
Ctrl + X Cut

Ctrl + C Copy
Ctrl +V Paste
Ctrl+Z Undo
Ctrl + S Save
Ctrl + Q Quit

Chapter 1 ¢ Basic Skills
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Access Keys

A menubar is a bar at the top of a window that contains the menus for the application.
An access key is an underlined letter in a menubar, menu, or dialog that you can use to
perform an action. On a menubear, the access key for each menu is underlined.

To open a menu, press Alt, then press the access key. In the menu, the access key for
each menu item is underlined. To choose a menu item, press the access key for the
menu item. The following table shows example access keys from the Text Editor
application:

Access Keys Function
Alt+F Opens the File menu.
N Chooses the New item on the File menu.

You can also use access keys to access elements in a dialog. In a dialog, one letter in

most dialog elements is underlined. To access a particular dialog element, press Alt,

then press the access key. The following table shows an example access key from the
Preferences dialog in the Text Editor application:

Access Key Function
Alt+U Gives focus to the Use default theme font
check box.

You can use also other keys to navigate within a window or dialog.

Key Function

Tab Moves the focus from element to element in a window or
dialog.

Arrow keys Use the arrow keys to perform the following actions:

®  In a menubar, move the focus from one menu to the
next menu. In an open menu, move the focus from one
menu item to the next menu item.

B Move the focus from one option to the next option to
make your selection, for example, within a group of
radio buttons in a dialog.

B Change the value that a spin box displays.
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Using Windows and Dialogs

This section provides information on how to use windows and dialogs.

To Resize Panes in Windows

Some windows contain more than one pane. A pane is a subdivision of a window. For
example, the Nautilus window contains a side pane and a view pane. A window that
contains panes has a resize handle on the edge between the panes. To resize the pane,
grab the resize handle, then drag the edge to the size you require.

Using Tables

Some windows contain information that is organized in a table. This section describes
how to work with tables.

To change the width of a column, drag one of the vertical edges of the column.

In some tables, you can sort the information by a particular column. To sort
information in a table, click on the heading on top of the column by which you want
to sort the information. An up arrow is displayed in the column heading by which the
table is sorted. The following figure shows the up arrow.

[ =]

To reverse the sort order, click on the column heading again. The up arrow changes to
a down arrow. The down arrow indicates that the information in the column is sorted
in reverse order.

In some tables, you can select multiple items. The following table describes how to
select items in tables.

Task Action

Select an item Click on the item.

Select a group of contiguous Press-and-hold Shift. Click on the first item in the group,
items then click on the last item in the group.
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Task Action

Select multiple items Press-and-hold Ctrl. Click on the items that you want to
select.
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CHAPTER 2

Overview of the Desktop

This chapter introduces you to the features and main components of the GNOME
desktop. Before you start to use the desktop read this chapter to familiarize yourself
with the various features, and how the main components work. The desktop is very
configurable, so this chapter describes the typical default configuration, covering the
following topics.

“Introducing Desktop Components” on page 27
“Panels” on page 30

“Menus” on page 33

“Windows in the Desktop” on page 34
“Workspaces” on page 36

“Nautilus File Manager” on page 37
“Desktop Background” on page 39
“Start Here Location” on page 40
“Desktop Preferences” on page 41
“Applications” on page 42

“To Find Out More” on page 43

Introducing Desktop Components

When you start a desktop session for the first time, you should see a default startup
screen, with panels, windows, and various icons. Figure 2-1 shows a typical desktop.
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FIGURE 2-1 A Typical Desktop

The major components of the desktop are as follows:

m  Panels

Panels are areas on your desktop from which you can access all of your system
applications and menus. Panels are very configurable. A particularly important
panel in Figure 2-1 is the Menu Panel. The Menu Panel stretches the full width of
the top edge of the desktop. The Menu Panel includes two special menus, as
follows:

m  Applications menu: Contains all applications and configuration tools. This
menu also includes the file manager and the help browser.

m  Actions menu: Contains various commands that perform desktop functions, for
example Search for Files and Log Out.
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Click on the icon at the extreme right of the Menu Panel to display a list of all open
windows.

Menus

You can access all desktop functions through menus. The Menu Panel contains
menus, so you can use a combination of menus and panels to perform your tasks.
You can use the Applications menu and the Actions menu to access almost all of
the standard applications, commands, and configuration options.

You can also access the items in the Applications and Actions menus from the
GNOME Menu. The items in the Actions menu are at the top level of the GNOME
Menu.

Windows

You can display many windows at the same time. You can run different
applications in each window. The window manager provides frames and buttons
for windows. The window manager enables you to perform standard actions such
as move, close, and resize windows.

Workspaces

You can subdivide your desktop into separate workspaces. A workspace is a discrete
area on the desktop in which you can work. You can specify the number of
workspaces on your desktop. You can switch to a different workspace, but you can
only display one workspace at a time.

Nautilus file manager

The Nautilus file manager provides an integrated access point to your files and
applications. You can display the contents of your files within a Nautilus window,
or open the files in the appropriate application from Nautilus. You can use the
Nautilus file manager to manage your files and folders.

Desktop background

The desktop background lies behind all of the other components on the desktop.
The desktop background is an active component of the user interface. You can
place objects on the desktop background to quickly access your files and
directories, or to start applications that you use often. You can also right-click on
the background to open a menu.

Start Here location

The Start Here location provides an access point to some of the key features of the
GNOME desktop. You can access your GNOME applications and configuration
tools from the Start Here location. You can also access programs that enable you to
configure your system as a server, and to choose other system settings.

Desktop preferences

The GNOME desktop contains dedicated preference tools. Each tool controls a
particular part of the behavior of the desktop. To start a preference tool, choose
Applications — Desktop Preferences. Choose the item that you want to configure
from the submenus.
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The most powerful features of the desktop are the high degree of configurability and
the multiple ways that you can perform tasks.

The desktop provides interoperability of the desktop components. Usually, you can
perform the same action in several different ways. For example, you can start
applications from panels, from menus, or from the desktop background.

Your system administrator can make configuration changes to suit your needs, so that
the desktop might not be exactly the same as described in this chapter. Nevertheless,
this chapter provides a useful quick guide to how to work with the desktop.

30

Panels

You can add or delete panels at any time. When you start a session for the first time,
the desktop usually contains at least two panels, as follows:

= Menu Panel
m  Edge panel at the bottom of the desktop

You can perform the following actions with panels:

Create panels.

Delete panels.

Hide panels.

Add objects to panels.
Manipulate panel objects.

To Create Panels

To create a panel follow these steps:

1. Right-click on a vacant space on any panel, then choose New Panel.
2. Choose the type of panel that you want to create from the submenu. The panel is
added to the desktop.

You can create as many panels as you want. However, you can only create one Menu
Panel. You can create different types of panel to fit your own requirements. You can
customize the behavior and appearance of your panels. For example, you can change
the background of your panels.

To Delete Panels

To delete a panel, right-click on the panel then choose Delete This Panel.
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To Hide Panels

Except for the Menu Panel, panels can have hide buttons at each end of the panel. You
click on the hide buttons to hide or show the panel.

To Add Objects to Panels

A panel can hold several types of objects. The panel in Figure 2-2 contains each type
of panel object.

Calculator CD Player Lock
launchear button

FIGURE 2-2 A Panel With Various Panel Objects

You can add any of the following objects to all types of panels:
m  Applets

Applets are small, interactive applications that reside within a panel, for example
CD Player in Figure 2-2. Each applet has a simple user interface that you can
operate with the mouse or keyboard. The following applets appear in your panels
by default:

= Window List: Displays a button for each window that is open. You can click on
a window list button to minimize and restore windows. By default, Window
List appears in the edge panel at the bottom of the desktop.

m  Workspace Switcher: Displays a visual representation of your workspaces. You
can use Workspace Switcher to switch between workspaces. By default,
Workspace Switcher appears in the edge panel at the bottom of the desktop.

To add an applet to a panel, right-click on a vacant space on the panel, then choose
Add to Panel. Choose the applet that you require from one of the following
submenus:

m  Accessories
®  Amusements
m  Internet
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m  Multimedia
= Utility

Launchers

A launcher starts a particular application, executes a command, or opens a file. The
calculator icon in Figure 2-2 is a launcher for the Calculator application. A launcher
can reside in a panel or in a menu. Click on the launcher to perform the action that
is associated with the launcher.

You can create your own launchers for applications. For example, you can create a
launcher for a word processor application that you use frequently, and place the
launcher in a panel for convenient access. To add a new launcher to a panel,
right-click on a vacant space on the panel, then choose Add to Panel — Launcher.

Alternatively, to add a launcher from a menu, right-click on a vacant space on the
panel, then choose Add to Panel — Launcher from menu. Choose the launcher to
add from the submenus.

Menus

You can access all desktop functions through menus. The default panels contain
menus, SO you can use a combination of menus and panels to perform your tasks.
To open a menu from a panel, click on the icon that represents the menu. To open a
menu from the Menu Panel, click on the text that represents the menu.

Menus that you add to your panels are represented by an icon with an arrow. The
arrow indicates that the icon represents a menu. The icon in Figure 2-2 is the icon
that is displayed when you add the Desktop Preferences menu to a panel.

You can also add the GNOME Menu to any of your panels. To add the GNOME
Menu to a panel, right-click on a vacant space on the panel, then choose Add to
Panel - GNOME Menu.

Drawers

Drawers are sliding extensions to a panel that you can open or close from a drawer
icon, as shown in Figure 2-2. Drawers can help you to organize your work when
you run a lot of applications simultaneously. You can place all the same functional
elements in a drawer that you can put in any other type of panel.

To add a drawer to a panel, right-click on a vacant space on the panel, then choose
Add to Panel — Drawer.

To open a drawer click on the drawer. To close a drawer click on the drawer again.
Lock button and Log Out button

The Lock button enables you to lock your screen. The lock icon in Figure 2-2 is the
Lock button. The Lock button enables you to end your session.

To add the buttons to a panel, right-click on a vacant space on the panel, then
choose Add to Panel. You can then choose the button you require.

Screenshot button, Search button, and Run button

The Screenshot button enables you to take a screenshot of the desktop. The Search
button opens the Search Tool application, from which you can search for files. The
Run button opens the Run Program dialog, from which you can run commands.
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To Manipulate Panel Objects

You can manipulate panel objects in the following ways:

®  Move objects within a panel, or to another panel.

You can move any object to another location in the panel. You can also move an
object from one panel to another panel. Use the middle mouse button to drag the
panel object to the new location.

®m  Copy menu items to a panel.

Drag the item from the menu to the panel. Alternatively, if the menu item is a
launcher right-click on the menu item, then choose Add this launcher to panel.

Menus

You can access all desktop functions through menus. Your default panels contain
menus, SO you can use a combination of menus and panels to perform your tasks. The
Menu Panel contains Applications and Actions menus. You can also add the GNOME
Menu to your panels.

You can use the Applications menu and the Actions menu to access almost all of the
standard applications, commands, and configuration options. You can also access the
items in the Applications and Actions menus from the GNOME Menu.

To add a GNOME Menu to a panel, right-click on the panel then choose Add to Panel
— GNOME Menu. The GNOME Menu is represented by a stylized footprint, as
follows:

ST

[

Click on the GNOME Menu button on a panel to open the GNOME Menu.

You can add as many additional menus as you want to any of your panels. To open a
menu that you add to a panel, click on the menu icon on the panel. You can perform
other actions on your menus, such as copy menu items to panels.
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Windows in the Desktop

You can display many windows at the same time on your desktop. Each window has a
frame. The window frame contains active control elements that you can use to work
with the window.

Types of Windows

The desktop features the following types of window:

m  Application windows

When you run an application, a frame usually borders the window. The top edge
of the application window contains a titlebar. The titlebar contains buttons that you
can use to work with the window. The buttons in an application window frame
enable you to perform actions such as open the Window Menu, or close the
window. The Window Menu provides commands that you can perform on the
window.

®  Dialog windows

Dialog windows are associated with interactive processes. A dialog window
consists of the window frame, and a single interactive pane that provides
information and controls for the user. This manual refers to the interactive part of a
dialog window as a dialog. The frame of a dialog window contains buttons that
enable you to open the Window Menu, or to close the dialog window.

To Manipulate Windows

You use the frame of an application window or dialog window to perform various
actions with the window. Most of the control elements are located on the top edge of
the window frame. Figure 2-3 shows the top edge of a frame for a typical application
window.
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FIGURE 2-3 Top Edge of Frame for a Typical Application Window

The active control elements of the window frame are as follows:

Control Element Description

Window Menu button Click on the Window Menu button to open the
Window Menu.

Titlebar You can use the titlebar to move and shade the
window.

Minimize button Click on the Minimize button to minimize the
window.

Maximize button You can use the Maximize button to maximize and

restore the window.

To maximize a window click on the Maximize button.
To restore the window click on the Maximize button

again.

Close Window button Click on the Close Window button to close the
window.

Border Right-click on the border to open the Window Menu.

To change the size of windows grab the border of the window, but not the titlebar.
Drag the border until the window is the size that you require.

To Give Focus to a Window

A window that has focus can receive input from the mouse and the keyboard. Only
one window can have focus at a time. The window that has focus has a different
appearance than other windows.

You can use the following elements to give focus to a window:
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Element Action

Mouse Click on the window, if the window is visible.

Shortcut keys Use shortcut keys to switch between the windows that are
open. To give focus to a window, release the keys. The default
shortcut keys to switch between windows are Alt + Tab.

Window List Click on the button that represents the window in Window
List.
Workspace Switcher Click on the window that you want to give focus to in the

Workspace Switcher display.

Workspaces

You can display many windows at the same time on your desktop. Your windows are
displayed in subdivisions of your desktop that are called workspaces. A workspace is
a discrete area on the desktop in which you can work.

Every workspace on the desktop contains the same desktop background, the same
panels, and the same menus. However, you can run different applications, and open
different windows in each workspace. You can display only one workspace at a time
on your desktop but you can have windows open in other workspaces.

Workspaces enable you to organize the desktop when you run many applications at
the same time. When your current workspace becomes crowded with windows, you
can move your work to another workspace. You can also switch to another workspace
then start more applications.

Workspaces are displayed in the Workspace Switcher applet. In Figure 2—4, Workspace

Switcher contains four workspaces. The first three workspaces contain open windows.
The last workspace does not contain currently active windows.

[t 5

FIGURE 2-4 Workspaces Displayed in Workspace Switcher

To Switch Between Workspaces

You can switch between workspaces in the following ways:

m  In Workspace Switcher, click on the workspace where you want to work.
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m  Press Ctrl + Alt + right arrow to switch to the workspace on the right of the current

workspace.

m  Press Ctrl + Alt + left arrow to switch to the workspace on the left of the current
workspace.

To Add Workspaces

To add workspaces to your desktop, right-click on the Workspace Switcher applet,
then choose Preferences. The Workspace Switcher Preferences dialog is displayed.
Use the Number of workspaces spin box to specify the number of workspaces that
you require.

Nautilus File Manager

The Nautilus file manager provides an integrated access point to your files,

applications, and FIP sites. To open a Nautilus window, choose Applications — Home
Folder. The following figure shows a Nautilus window that displays the contents of a

folder.
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A Nautilus window contains the following panes:

®  Side pane

Enables you to navigate through your files. This pane also displays information
about the current file or folder. The side pane is on the left side of the window.

®m  View pane

Displays the contents of files and folders. The view pane is on the right side of the

window.

Nautilus enables you to do the following:

m  View files and folders

You can view your files and folders as icons or as a list. You can view the contents
of some types of file within a Nautilus window. Alternatively, you can open the

files in the appropriate application from Nautilus.

®  Manage your files and folders

You can use Nautilus to create, move, copy, rename, and remove files and folders.

®  Run scripts
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You can run scripts from Nautilus, and you can select files and folders on which to
run your scripts.

m  Customize your files and folders

You can add emblems to your files and folders to indicate particular states. For
example, you can add an Important emblem to a file to indicate that the file is
important. You can also customize folders in the following ways:

®  Add a note to a folder.
®  Specify a custom background pattern for a folder.
®  Specify a zoom setting for a folder.

Nautilus also creates the desktop background.

To Open Files From the Nautilus File Manager

To navigate to the folder where the file that you want to open resides, double-click on
the folder icons in the view pane. When the file that you want to open is displayed,
double-click on the file icon to open the file.

To Move Files Between Folders

You can move files between folders by opening two or more Nautilus windows. Open
a different folder in each window, then drag the files from one window to the other.

Desktop Background

The desktop background is an active component of the desktop. You can use the
desktop background to perform the following actions:

m  Start your applications, and open your files and folders.

You can add desktop background objects for convenient access to the files, folders, and
applications that you use frequently. For example, you add a launcher for an
application that you use often.

®m  Open the Desktop Background menu.

Right-click on the desktop background to open the Desktop Background menu.
You can use the Desktop Background menu to perform actions on the desktop
background.

The Nautilus file manager manages the desktop background.
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To Open Desktop Background Objects

To open an object from the desktop background, double-click on the object. You can
set your preferences in a Nautilus window so that you click once on an object to
execute the default action.

To Add Objects to the Desktop Background

You can add desktop background objects for convenient access to files, folders, and
applications that you use frequently. You can add objects to your desktop background
in the following ways:

m  Use the Desktop Background menu to add a launcher to the desktop background.

®  Drag an object from a file manager window to the desktop background. For
example, you can create a symbolic link to a file that you use often, then drag the
link to your desktop background. The icon for the link is moved to the desktop
background. To open the file, double-click on the icon. You can also drag files and
folders to the desktop background.

®  Drag an application launcher from a menu to the desktop background. For
example, you can open a menu that contains a launcher for an application that you
use often, then drag the launcher to your desktop background.

40

Start Here Location

o

Start Here

The Start Here location enables you to access the following functions:

m  Applications

Double-click on Applications to access your key GNOME applications. You can
also access the Applications menu through the GNOME Menu and the Menu
Panel.

m  Desktop Preferences

Double-click on Desktop Preferences to customize your desktop.
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®  Programs that enable you to configure your system as a server, and to choose other
system settings.

You can access the Start Here location in the following ways:

®  From a Nautilus window

Choose Go — Start Here. The contents of the Start Here location are displayed in
the window.

®  From the desktop background

Double-click on the Start Here object on the desktop background. The contents of
the Start Here location are displayed in a Nautilus window.

Desktop Preferences

You can use desktop preference tools to configure almost every feature of the desktop.
Each tool controls a particular part of the behavior of the desktop. For example, you
can use a preference tool to select a theme for your desktop. A theme is a group of
coordinated settings that specify the visual appearance of a part of your interface.

For convenience, the tools are grouped under the following headings:

®  Basic
®  Accessibility
m  Advanced

You can open your desktop preference tools in either of the following ways:

®  Choose Applications — Desktop Preferences. Choose the item that you require
from the submenus.

®  Double-click on the Start Here object on the desktop background. A Nautilus
window opens at the Start Here location. Double-click on the Desktop Preferences
object in the Nautilus window to display the desktop preference tools. Double-click
on the item that you require.
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Applications

The applications that are provided with the GNOME desktop share several
characteristics. For example, the applications have a consistent look-and-feel. The
applications share characteristics because the applications use the same programming
libraries. An application that uses the standard GNOME programming libraries is
called a GNOME-compliant application. For example, Nautilus and the gedit text editor
are GNOME-compliant applications.

GNOME provides libraries in addition to the libraries provided by your operating
system. The libraries enable GNOME to run your existing applications as well as
GNOME-compliant applications. For example, if your operating system is
UNIX-based, you can run your current X11 applications and Motif applications from
the GNOME desktop.

Some of the features of GNOME-compliant applications are as follows:

m  Consistent look-and-feel

GNOME-compliant applications have a consistent look-and-feel.
GNOME-compliant applications use the look-and-feel settings that you specify in
the desktop preference tools. You can use the following tools to change the
look-and-feel of your GNOME-compliant applications:

m  Applications — Desktop Preferences — Menus & Toolbars
m  Applications — Desktop Preferences — Theme

m  Menubars, toolbars, and statusbars

Most GNOME-compliant applications have a menubar, a toolbar, and a statusbar.
The menubar always contains a File menu and a Help menu. The File menu always
contains an Quit menu item, and the Help menu always contains an About menu
item.

A toolbar is a bar that appears under the menubar. A toolbar contains buttons for
the most commonly-used commands. A statusbar is a bar at the bottom of a
window that provides information about the current state of what you are viewing
in the window. GNOME-compliant applications might also contains other bars. For
example, Nautilus contains a location bar.

Some of the bars in GNOME-compliant applications are detachable. That is, the bar
has a handle that you can grab then drag the bar to another location. You can drag
the bar to snap to another side of the window, or to another part of the desktop.
For example, you can detach the menubar, toolbar, and location bar in the Nautilus
file manager.

m  Default shortcut keys

GNOME-compliant applications use the same shortcut keys to perform the same
actions. For example, to quit a GNOME-compliant application, press Ctrl + Q. To
undo an action in a GNOME-compliant application, press Ctrl + Z.
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®  Drag-and-drop

GNOME-compliant applications use the same protocol to implement
drag-and-drop operations. Therefore, GNOME-compliant applications provide
consistent feedback when you drag-and-drop items.

The use of the same protocol also enables GNOME-compliant applications to
interoperate in a sophisticated manner. For example, GNOME-compliant
applications recognize the format of the items that you drag. When you drag a
HTML file from a Nautilus window to a web browser, the file is displayed in
HTML format in the browser. However, when you drag the HTML file to a text
editor, the file is displayed in plain text format in the text editor.

To Find Out More

The desktop provides help if you want to find out more about the following areas:

m  Desktop topics
m  Applets
®  Applications

To Find Out More About Desktop Topics

You can find out more about particular desktop topics in the integrated Yelp help
system. To start the Yelp help system, choose Applications — Help.

To Find Out More About Applets

To find out more about a specific applet, right-click on the applet, then choose Help.

To Find Out More About Applications

To find out more about a specific application, start the application, then choose Help
— Contents. Alternatively, start the application then press F1.
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CHAPTER 3

Desktop Sessions

This chapter provides the information you need to start, manage, and end a desktop
session.

“Starting a Desktop Session” on page 45
“Locking Your Screen” on page 46
“Managing the Session” on page 49
“Ending a Session” on page 50

Starting a Desktop Session

A desktop session occurs between the time that you log in to the desktop and the time
that you log out. The login screen, displayed by the Login Manager, is your gateway
to the desktop. The login screen provides fields for you to enter your username and
password. The Options menu on the login screen lists your login options, for example
you can select the language of your session.

You start a session when you log in. The session manager starts after the Login
Manager authenticates your username and password. The session manager enables
you to manage the session. For example, you can save the state of your most recent
session and return to that session the next time that you log in. The session manager
saves and restores the following:

m  The appearance and behavior settings, for example fonts, colors, and mouse
settings.

m  The applications that you were running, for example file manager and text editor
windows. You cannot save and restore applications that the session manager does
not manage. For example, if you start the vi editor from the command line in a
terminal window, session manager cannot restore your editing session.
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Locking Your Screen

This section provides information on how to lock your screen, and how to configure
your screensaver.

To Lock Your Screen

@

To lock the screen, perform one of the following actions:

m  Choose Actions — Lock Screen.
m  If the Lock button is present on a panel, click on the Lock button.

To add the Lock button to a panel, right-click on the panel. Choose Add to Panel —
Lock button.

When you lock your screen, the screensaver starts. To unlock the screen, move your
mouse to display the locked screen dialog. Enter your username and password in the
locked screen dialog, then press Return.

Note — To lock your screen correctly, you must have a screensaver enabled.

To Configure Your Screensaver

A screensaver is an application that you can use to replace the image on your screen
when the screen is not in use. You can use screensavers in the following ways:

m  Activate after a specified period of idle time.
®  Activate when you lock your screen.
®  Manage power used by your monitor when your system is idle.

To configure your screensaver application, perform the following steps:

1. Right-click on the Lock button, then choose Properties from the popup menu. An
XScreenSaver dialog is displayed.
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If the Lock button is not present on a panel, you can add the button to a panel. To
add the Lock button to a panel, right-click on the panel. Choose Add to Panel —

Lock button.

2. To configure your screensaver application, use the elements in the Display Modes
tab. The following table describes the dialog elements on the Display Modes

tabbed section:

Setting Function

Mode Use the drop-down list box to specify the behavior of
the screensaver application. Select from the following
options:

B Disable Screen Saver: Select this option if you do
not want to use the screensaver application.

B Blank Screen Only: Select this option if you want
your screen to become blank when your screen
locks.

B Only One Screen Saver: Select this option if you
want to display a single screensaver display from
the display list box when your screen locks.

B Random Screen Saver: Select this option if you
want to display a random selection of screensaver
displays from the screensaver display list box
when your screen locks.

Display list box Select the screensaver display that you require from
the list box.

Blank After Specify how long to wait after the last use of the
mouse or keyboard, to activate the screensaver.

Cycle After Specify how long to show a particular screensaver

Lock Screen After

Preview

Settings

display before the next display.

Select this option if you want the screen to lock after
the screensaver is activated. Use the spin box to
specify the delay between the activation of the
screensaver and when the screen locks.

Click on this button to preview the screensaver
display that is selected in the screensaver display list
box. To stop the preview, press any key or click a
mouse button.

Click on this button to display the options for the
screensaver display that is selected in the screensaver
display list box.

3. To configure advanced options, click on the Advanced tab. The following table
describes the dialog elements on the Advanced tabbed section:
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Setting

Function

Grab Desktop Images

Grab Video Frames

Choose Random Image

Verbose Dialognostics

Display Subprocess Errors

Display Splash Screen at Startup

Power Management Enabled

Standby After

Suspend After

Off After

Install Colormap

Fade to Black When Blanking

Fade from Black When
Unblanking

Some screensavers can take a screenshot of your
desktop, then manipulate the screenshot to create
your screensaver display. Select this option to enable
screensavers to take a screenshot of your desktop.

Some screensavers can capture a frame of video, then
manipulate the captured image to create your
screensaver display. If your system has a video
capture card, select this option to enable screensavers
to capture a frame of video.

Select this option to enable screensavers to use
images from a directory that you select. Type the
path for the directory in the field. Alternatively, click
Browse to display a dialog from which you can select
a directory.

Select this option if you want to display screensaver
diagnostic information.

Select this option if you want to display errors
related to screensaver subprocesses on screen.

Select this option to if you want Xscreensaver to
display a splash dialog when Xscreensaver starts.

Select this option to enable power management of
your monitor. Power management can reduce energy
consumption by your monitor when you are not
using the monitor.

Specify how long to wait to put the monitor in
standby mode. When the monitor is in standby
mode, the screen is black.

Specify how long to wait to put the monitor in
power-saving mode.

Specify how long to wait to switch off monitor.

Select this option to install a private colormap when
the screensaver is active. Use of a private colormap
might improve the quality of the color in particular
screensaver displays.

Select this option if you want your display to fade to
black when the screensaver activates.

Select this option if you want your display to fade
from black to the screen contents when the
screensaver stops.
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Setting Function

Fade Duration Specify how long to take to fade to black when the
screensaver activates.

4. Click on the Close Window window frame button to close the XScreenSaver
dialog.

Managing the Session

To configure the session management of the desktop, choose Applications — Desktop
Preferences — Advanced — Sessions. The Sessions preference tool recognizes the
following types of application:

®  Applications that are session-managed. When you save the settings for your
session, the session manager saves all of the session-managed applications. If you
log out, then log in again, the session manager automatically starts the
session-managed applications.

m  Applications that are not session-managed. When you save the settings for your
session, the session manager does not save any applications that are not
session-managed. If you log out, then log in again, the session manager does not
start non-session-managed applications. You must start the application manually.
Alternatively, you can use the Sessions preference tool to specify
non-session-managed applications that you want to automatically start.

Defining Session Behavior When You Log In and
Log Out

To set how a session behaves when you log in and log out, choose Applications —
Desktop Preferences — Advanced — Sessions. Make the changes you require in the
Session Options tabbed section. For example, you can select to display a splash screen
when you log in.

To Use Startup Applications

You can configure your sessions to start with applications that are not
session-managed. To configure non-session-managed startup applications, choose
Applications — Desktop Preferences — Advanced — Sessions. Use the Startup
Programs tabbed section to add, edit, and delete applications. If you save your
settings and log out, the next time that you log in, the startup applications start
automatically.
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To Browse Applications in the Current Session

To browse the applications in the current session, choose Applications — Desktop
Preferences — Advanced — Sessions. The Current Session tabbed section lists the
following;:

= All GNOME applications that are currently running, that can connect to the session
manager, and that can save the state of the application.

m  All desktop preference tools that can connect to the session manager, and that can
save the state of the tool.

You can use the Current Session tabbed section to perform a limited number of
actions on the session properties of an application or preference tool. For example, you
can edit the startup order, and restart style of any GNOME application or desktop
preference tool that is in the list.

To Save Session Settings

To save your session settings, perform the following steps:

1. Configure your session to automatically save settings when you end the session. To
configure your session, choose Applications — Desktop Preferences — Advanced
— Sessions. The Sessions preference tool starts. Select the Automatically save
changes to session option on the Session Options tabbed section.

2. End your session.
If you do not select the Automatically save changes to session option, when you log

out, a dialog asks if you want to save your current settings. To save your settings,
select the option, then continue to log out.

50

Ending a Session

To end your session, close all your currently active processes, then perform one of the
following actions:
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®  Click on the Log Out button.
®m  Choose Actions — Log Out.
m  Open the GNOME Menu, then choose Log Out.

Before you end a session, you might want to save your current settings so that you can
restore the session later. During the logout process, a dialog asks if you want to save
your current settings. In the Sessions preference tool, you can select an option to
automatically save your current settings.
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CHAPTER 4

Working With Panels

The information in this chapter describes how to use panels.

“Introducing Panels” on page 53
“Managing Your Panels” on page 55
“Panel Objects” on page 61
“Launchers” on page 65

“Menus” on page 69

“Applets” on page 63

“Drawers” on page 70

“Log Out Button” on page 73

“Lock Button” on page 73

Introducing Panels

A panel is an area on your desktop from which you can run applications and applets,
and perform other tasks. When you start a session for the first time, the desktop
contains the following panels:

= Menu Panel
m  Edge panel at the bottom of the desktop

The following sections describe these panels.

Menu Panel

The Menu Panel stretches the full length of the top edge of your screen. The Menu
Panel includes textual rather than graphical menus. Figure 4-1 shows the Menu Panel.
Your system administrator might have set your default Menu Panel according to your
local requirements, so you might see a slightly different Menu Panel.
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FIGURE 4-1 Typical Menu Panel

The typical Menu Panel contains the following objects:

Object Description

Applications menu The Applications menu contains the standard GNOME
applications.

Actions menu The Actions menu provides commands that enable you to

perform desktop tasks.

Home folder launcher Click on this launcher to open your home folder in a Nautilus
file manager window.

Terminal launcher Click on this launcher to start the Terminal application. Terminal
provides access to a UNIX command line.

Clock applet Clock shows the current time. Click on the time readout to
display a menu of clock commands.

Volume Control applet Volume Control enables you to control the volume of the speaker
on your system.

Window list icon The window list is a list of all your open windows. To give focus
to a window, click on the icon at the extreme right of the Menu
Panel, then choose the window.

Unlike other types of panel, you can only have one Menu Panel at a time on your
desktop.

Bottom Edge Panel

On startup, an edge panel stretches the full length of the bottom edge of the desktop.
Figure 4-2 shows a typical bottom edge panel. Your system administrator might have
set your default bottom edge panel according to your local requirements, so you might
see a slightly different bottom edge panel.
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FIGURE 4-2 Typical Bottom Edge Panel

The bottom edge panel contains the following applets:

®m  Window List: Displays a button for each window that is open. Window List
enables you to minimize and restore windows.

m  Workspace Switcher: Enables you to navigate between your workspaces.

You can change the behavior and appearance of your bottom edge panel to suit your
requirements. You can also add or remove objects from your bottom edge panel. You
can create multiple panels, and choose different properties, objects, and backgrounds
for each panel. You can also hide panels.

Managing Your Panels

The following sections describe how to manage your panels.

To Add a New Panel

You can add different types of panels to your desktop. Table 4-1 lists the types of
panel that you can add, and their characteristics.

TABLE 4-1 Types of Panel

Panel Type

Snap Behavior

Size

Corner Panel

Edge Panel

Floating Panel

Snaps to one of the edges of the
screen, but can only snap to the
center or the corner of the edge.

Snaps to one of the edges of the
screen. The startup panel at the
bottom of the desktop is an
example of an edge panel.

Does not snap to anything. You
can place a floating panel
anywhere on your desktop.

Stretches as much as required to
display the objects on the panel.

Stretches the full length of the
edge that the panel snaps to.

Stretches as much as required to
display the objects on the panel.
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TABLE 4-1 Types of Panel (Continued)
Panel Type Snap Behavior Size
Sliding Panel Snaps to one of the edges of the Stretches as much as required to

Menu Panel

screen, can snap to any point on
the edge.

Snaps to the top edge of the

display the objects on the panel.

Stretches the full length of the top

screen. You cannot move the
Menu Panel.

edge of the screen. You can only
have one Menu Panel on your
desktop.

To add a panel perform the following steps:

1. Right-click on a vacant space on any panel, then choose New Panel.

2. Choose the type of panel that you want to add. The new panel is added to the
desktop. The new panel contains no objects, except for a Menu Panel.

You can customize the new panel to suit your preferences.

To Interact With a Panel

To interact with a panel, you must left-click, middle-click, or right-click on a vacant
space on the panel. You can also middle-click or right-click on one of the hide buttons
to select the panel, if the panel has no vacant space. If the hide buttons are not visible
on a panel, modify the properties of the panel so that the hide buttons are visible.

You use the mouse buttons to interact with a panel in the following ways:

Middle-click Enables you to grab a panel, then drag the panel to a new

location.

Right-click Opens the panel popup menu.

To Move a Panel

You can move panels to different locations on your desktop. To move a panel,
middle-click and hold on any vacant space on the panel, then drag the panel to the
new location.

When you drag a floating panel, the panel follows the mouse pointer. The panel does
not snap to any part of the desktop. When you drag a corner panel, an edge panel, or
a sliding panel, the panel snaps to the edge of the screen.
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Note — You cannot move the Menu Panel.

To Hide a Panel

You can hide or show panels, except for the Menu Panel. To hide a panel, use a hide
button. If the hide buttons are not visible on a panel, modify the panel properties so
that the hide buttons are visible.

Hide buttons are at either end of a panel. The hide buttons contain an optional arrow
icon. The following illustration shows hide buttons.

o

o

To hide a panel, click on one of the hide buttons. The panel reduces in the direction of
the arrow on the hide button. The hide button at the other end of the panel remains
visible.

To show a hidden panel again, click on the visible hide button. The panel expands in
the direction of the arrow on the hide button. Both hide buttons are now visible.

You can set a panel to autohide. When you set autohide, the panel hides automatically
when the mouse is not pointing to the panel. The panel reappears when you point to
the part of the screen where the panel resides. To set your panel to autohide, modify
the properties of the panel.

Note — On a corner panel, the behavior of the hide buttons is slightly different. If the
panel is in one of the corners of the screen, you can use the hide buttons as follows:

®  To hide the panel, click the hide button that is closest to the edge of the screen, as
normal.

m  To move the panel to the opposite corner of the screen, click the hide button that is
farthest from the edge of the screen.

To Modify Panel Properties

To modify preferences for all panels, choose Applications — Desktop Preferences —
Advanced — Panel, then make the changes that you require. For example, you can
specify various settings related to the appearance and behavior of panel objects.
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You can also modify properties for each individual panel. You can change the features
for each panel, such as the type of the panel, the hide behavior, and the visual
appearance.

Note — You cannot modify properties for the Menu Panel.

To modify the properties of a panel perform the following steps:

1. Right-click on a vacant space on the panel, then choose Properties to display the
Panel Properties dialog. The following figure shows the Panel Properties dialog
for the edge panel at the bottom of your desktop.

Panel Properties
Edge Panel ] Background ]

Position:

= —

Size: ¥ Small (24 pixelsy |3

[ &utohide
[T Show hide buttons

[T &rrows on hide buttsns

@HEHJ X Close :

The Panel Properties dialog contains the following tabbed sections:

m Panel_type Panel
m  Background

2. To modify panel size, position, and hiding properties, click on the Panel_type Panel
tab. The following table describes the dialog elements on the Panel_type Panel
tabbed section:

Dialog Element Description

Position Select the position of the panel on your desktop. Click on the
required position for the panel.
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Dialog Element

Description

Size

Orient horizontally

Orient vertically

Horizontal offset

Vertical offset

Screen edge offset

Autohide
Show hide buttons

Arrows on hide button

Select the size of the panel.

Floating panel only. Select this option to display the panel
horizontally.

Floating panel only. Select this option to display the panel
vertically.

Floating panel only. Use the spin box to specify the distance of
the panel from the left edge of the desktop.

Floating panel only. Use the spin box to specify the distance of
the panel from the top edge of the desktop.

Sliding panel only. Use this spin box to specify the distance
between your panel and the edge of the desktop, in pixels.

Select this option to enable autohide.
Select this option to display hide buttons on your panel.

Select this option to display arrows on the hide buttons, if the
hide button is enabled.

3. To modify the panel background, click on the Background tab. The Background
tabbed section contains the following elements:

Dialog Element

Description

Background Type

Background Color

Choose the type of background for the panel. The choices are as

follows:

®  Default: The default background type. The standard
background depends on the settings in Applications —
Desktop Preferences — Theme.

®  Color: Enables you to choose a color for the panel
background.

®  Image: Enables you to choose an image for the panel
background.

If Background Type is Color, click on the Color to use button to
display the color selector dialog. Choose the color that you
require from the color selector dialog.
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Dialog Element Description

Image If Background Type is Image, choose the image to use on the
background of the panel. Specify the following settings for the
image background:

Do not scale image to fit Select this option to tile the
background image to fit the panel
background.

Scale image Select this option to scale the
background image to fit the panel
background. The width-to-height
ratio of the image is retained.

Stretch image Select this option to stretch the
background image to fit the panel
background. The width-to-height
ratio of the image is not retained.

Rotate image for vertical ~Select this option to rotate the
panels background image on a vertical
panel.

You can also drag a color or image on to a panel to set the color or image as the
background of the panel. For more information, see “To Drag a Color or Image to
the Background of a Panel” on page 60.

4. Click Close to close the Panel Properties dialog.

To Drag a Color or Image to the Background of a Panel

You can drag a color or image on to a panel to set the color or image as the
background of the panel. You can drag a color or image from many applications. For
example, you can drag a color from the Nautilus file manager to a panel to set the
color as the background of the panel. You can also drag a color from any color selector
dialog.

You can drag an image to a panel to set the image as the background of the panel. You
can also drag pattern images from the Nautilus file manager application to set the
background of the panel.

To Delete a Panel

To delete a panel from the desktop, right-click on the panel that you want to delete,
then choose Delete This Panel.
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Note — You must always have at least one panel on your desktop. If you have only one
panel on your desktop, you cannot delete that panel.

Panel Objects

This section describes the objects that you can add to your panels, and use from your
panels.

Interacting With Panel Objects

You use the mouse buttons to interact with a panel object in the following ways:

Left-click Launches the panel object.

Middle-click Enables you to grab an object, then drag the object to a new
location.

Right-click Opens the panel object popup menu.

You interact with applet panel objects in a different way. For more information, see “To
Select an Applet” on page 64.

To Add an Object to a Panel

You can add an object to a panel in several ways, as follows:

®  From the panel popup menu

Right-click on a vacant space on a panel to open the panel popup menu. The panel
popup menu contains an Add to Panel submenu. The Add to Panel submenu
enables you to add the following objects to your panels:

m  Applets in the following categories: Accessory, Amusement, Internet,
Multimedia, Utility.

m  Launchers
®  Launchers from menus
®  GNOME Menu

m  Drawers
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®  Buttons for quick access to common functions: Log Out button, Lock button,
Screenshot button, Search button, Run button.

= From any menu

When you right-click on a launcher in any menu, a popup menu for the launcher
opens. You can use this popup menu to add the launcher to a panel.

You can also drag menus, launchers, and applets from menus to panels.
®  From the file manager

Each launcher corresponds to a . desktop file. You can drag the . desktop file on
to your panels to add the launcher to the panel.

Each menu corresponds to a directory. You can drag the directory on to your panels
to add the directory to the panel as a menu object.

To Modity the Properties of an Object

Some panel objects have a set of associated properties. The properties are different for
each type of object. The properties specify details such as the following;

®  The command that starts a launcher application.
®  The location of the source files for a menu.
®  The icon that represents the object.

To modify the properties of an object perform the following steps:

1. Right-click on the object to open the panel object popup menu, as shown in Figure
4-3.

ﬁj Properties

Help |

= Rernove From Panel
Move

FIGURE 4-3 Panel Object Popup Menu

2. Choose Properties. Use the Properties dialog to modify the properties as required.
The properties in the Properties dialog depend on which object you select in step 1.

3. Click OK to apply the changes, then close the Properties dialog.

To Move a Panel Object

You can move panel objects within a panel, and from one panel to another panel. You
can also move objects between panels and drawers.

To move a panel object, middle-click and hold on the object and drag the object to a
new location. When you release the middle mouse button, the object anchors at the
new location.
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Alternatively, you can use the panel object popup menu to move an object, as follows:

1. Right-click on the object, then choose Move.

2. Point to the new location for the object, then click any mouse button to anchor the
object to the new location. This location can be on any panel that is currently on
your desktop.

Movement of a panel object affects the position of other objects on the panel. To
control how objects move on a panel, you can specify a movement mode. To specify
the movement mode, press one of the following keys as you move the panel object:

Key Movement Mode Description

No key Switched movement The object swaps places with other panel objects.
Switched movement is the default movement
mode.

Alt key Free movement The object jumps over other panel objects into the

next vacant space on the panel.

Shift key Push movement The object pushes other panel objects further
along the panel.

To Remove a Panel Object

To remove an object from a panel right-click on the object to open the panel object
popup menu, then choose Remove From Panel.

Applets

An applet is a small application whose user interface resides within a panel. You use
the applet panel object to interact with the applet. For example, the following figure
shows the following applets, from left to right:

®m  Window List: Displays the windows currently open on your system.
m  CD Player: Enables you to control the compact disc player on your system.

®  Volume Control: Enables you to control the volume of the speaker on your system.
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To Add an Applet to a Panel

You can add an applet to a panel from the panel popup menu. Right-click on any
vacant space on the panel to open the panel popup menu. Choose Add to Panel, then
choose the applet that you want to add from one of the following submenus:

Accessories
Amusements
Internet
Multimedia
Utility

Alternatively, drag the applet from the submenu on to the panel.

To Select an Applet

To modify the properties of an applet, you must first right-click on the applet to
display the panel object popup menu. To move an applet, you must middle-click on
the applet.

Some restrictions apply on where you can click on an applet in order to display the
panel object popup menu, or to move the applet, as follows:

®m  Some applets have popup menus of applet-specific commands that open when you
right-click on particular parts of the applet. For example, the Window List applet
has a vertical handle on the left side, and buttons that represent your windows on
the right side. To open the panel object popup menu for the Window List applet,
you must right-click on the handle. If you right-click on a button on the right side,
a popup menu for the button opens.

®m  Some applets have areas that you cannot use to select the applet. For example, the
Command Line applet has a field in which you enter commands. You cannot
middle-click or right-click on this field to select the applet. Instead, middle-click or
right-click on another part of the applet.

To Modity Preferences for an Applet

To modify the preferences for an applet perform the following steps:
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Right-click on the applet, then choose Preferences. Use the Preferences dialog to
modify the preferences as required. The preferences for applets vary depending on
the applet.

Click Close to close the Preferences dialog.

Launchers

When you click on a launcher, you initiate one of the following actions:

Start a particular application.
Execute a command.
Open a folder in a file manager window.

Open a browser at a particular Uniform Resource Locator (URL). A URL is the
address of a particular location on the Web.

You can find launchers in the following places on the desktop:

Panels: On panels, launchers are represented by icons.

Menus: On menus, launchers are represented by menu items. The menu items
usually have an icon beside the menu item.

Desktop background: On the desktop background, launchers are represented by
icons.

You can modify the properties of a launcher. For example, the properties of a launcher
include the name of the launcher, the icon that represents the launcher, and how the
launcher runs.

To Add a Launcher to a Panel

You can add a launcher to a panel in one of the following ways:

From the panel popup menu

To create a new launcher, right-click on any vacant space on the panel, then choose
Add to Panel — Launcher. A Create Launcher dialog is displayed. For more
information on how to complete this dialog, see “To Create a Launcher With the
Create Launcher Dialog” on page 66.

Alternatively, to add an existing launcher to the panel, choose Add to Panel —
Launcher from menu from the panel popup menu. Choose the launcher that you
want to add from the menu.

From any menu

Chapter 4 « Working With Panels 65



66

To add a launcher to a panel from any menu, perform one of the following steps:

®m  Open the menu that contains the launcher from the panel where you want the
launcher to reside. Right-click on the title of the launcher. Choose Add this
launcher to panel.

®  Open a menu that contains the launcher. Drag the launcher on to the panel.
From the file manager

To add a launcher to a panel from the file manager, find the . desktop file for the
launcher in your file system. To add the launcher drag the . desktop file to the
panel.

To Create a Launcher With the Create Launcher Dialog

To create a launcher with the Create Launcher dialog perform the following steps:

1. Right-click on any part of a panel to open the panel popup menu. Choose Add to

Panel — Launcher to display the Create Launcher dialog. The dialog displays the
Basic tabbed section.

" Create Launcher 7 [%]

Basic | fAdvanced |

Mame s |N0 hame

Generic name:|

Eomment:|

Command: | ﬂ Brouse, ..

Type: FApplication = |

Icony Mo Icon [ Run in Terminal

@Help x Cancel ‘ <9QK |

2. Enter the properties of the launcher in the dialog. The following table describes the

dialog elements on the Basic tabbed section:

Dialog Element Description

Name Use this text box to specify the name of the launcher. You can use
the Advanced tab to add translations of the name. This name is
the name that appears when you add the launcher to a menu or to
the desktop background.
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Dialog Element

Description

Generic name

Comment

Command

Type

Icon

Run in Terminal

Use this text box to specify the class of application to which the
launcher belongs. For example, you might type Text Editor in
this text box for a gedit launcher. You can use the Advanced tab to
add translations of the generic name.

Use this text box to specify a short description of the launcher.
The comment is displayed as a tooltip when you point to the
launcher icon on the panel. You can use the Advanced tabbed
section to add translations of the comment.

Use this field to specify a command to execute when you click on
the launcher.

Use this drop-down combination box to specify the type of

launcher. Select from the following:

B Application: Select this option to create a launcher that starts
an application.

B Link: Select this option to create a launcher that links to a file,
folder, or FTP site.

Choose an icon to represent the launcher. To choose an icon, click
on the No Icon button. An icon selector dialog is displayed.
Choose an icon from the dialog. Alternatively, to choose an icon
from another directory, click Browse. When you choose an icon,
click OK.

Select this option to run the application or command in a terminal
window. Choose this option for an application or command that
does not create a window in which to run.

3. To set advanced properties for the launcher, click on the Advanced tab. The
Launcher Properties dialog displays the Advanced tabbed section.
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4. Enter the advanced properties of the launcher in the dialog. The following table
describes the dialog elements on the top part of the Advanced tabbed section:

Dialog Element Description

Try this before using Enter a command here to check before starting the launcher.
If the command is executable and is in your path, the
launcher appears on the panel.

Documentation This field is not currently in use.

5. You can also add a translation of the Name, Generic name, and Comment fields
from the Basic tabbed section. To add a translation, enter the details of the
translation in the Name/Comment translations table as follows:

Field Description

First field Enter the two-letter code for the language for which you want to add a
translation.

Second field Enter the translation of the Name of the launcher.

Third field Enter the translation of the Generic name of the launcher.

Fourth field Enter the translation for the Comment for the launcher.

Then click on the Add/Set button.

To edit a translation, select the translation. The translated text appears in the lower
part of this dialog. Edit the fields as required, then click on the Add/Set button.
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6.

To remove a translation, select the translation, then click on the Remove button.

To create the launcher and close the Launcher Properties dialog, click OK.

To Modify the Properties of a Launcher

To modify the properties of a launcher perform the following steps:

1.
2.

Right-click on the launcher to open the panel object popup menu.

Choose Properties. Use the Launcher Properties dialog to modify the properties as
required. For more information on the Launcher Properties dialog, see “To Create
a Launcher With the Create Launcher Dialog” on page 66.

Click Close to close the Launcher Properties dialog.

Menus

You can add the following types of menu to your panels:

System menus: System menus contain the standard applications and tools that you
can use on your desktop. The Applications menu and Actions menu are system
menus. To add a system menu to a panel, right-click on a launcher in the menu,
then choose Entire menu — Add this as menu to panel.

GNOME Menu: You can access almost all of the standard applications, commands,
and configuration options from the GNOME Menu. To add a GNOME Menu to a
panel, right-click on any vacant space on the panel, then choose Add to Panel —
GNOME Menu. You can add as many GNOME Menu objects to your panels as you
want. By default, the GNOME Menu is represented on panels by a stylized
footprint icon, as follows:

S

Menus that you add to your panels are represented by an icon with an arrow. The
arrow indicates that the icon represents a menu or drawer. Figure 4—4 shows how
menus typically appear on panels.
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FIGURE 4-4 Typical Menu Objects on a Panel

Drawers

A drawer is an extension of a panel. You can open and close a drawer in the same way
that you can show and hide a panel. A drawer can contain all panel objects, including
launchers, menus, applets, other panel objects, and other drawers. When you open a
drawer, you can use the objects in the same way that you use objects on a panel.

The following figure shows an open drawer that contains two panel objects.
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The arrow on the drawer icon indicates that the icon represents a drawer or menu.

A

You can add, move, and remove objects from drawers in the same way that you add,
move, and remove objects from panels.

To Open and Close a Drawer

To open a drawer, click on the drawer object in a panel. You can close a drawer in the
following ways:

m  (Click on the drawer.
®  (Click on the drawer hide button.
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To Add a Drawer to a Panel

You can add a drawer to a panel in the following ways:

®m  From the panel popup menu

Right-click on any vacant space on the panel, then choose Add to Panel — Drawer.
®  From any menu

You can add a menu as a drawer object to a panel.

To add a menu as a drawer to a panel, open the menu from the panel. Right-click
on any launcher in the menu, then choose Entire menu — Add this as drawer to
panel.

To Add an Object to a Drawer

You add an object to a drawer in the same way that you add obijects to panels. For
more information, see “To Add an Object to a Panel” on page 61.

To Modify Drawer Properties

To modify preferences for all panels and drawers, choose Applications — Desktop
Preferences — Advanced — Panel, then make the changes that you require. For
example, you can select various options related to the appearance and behavior of
objects on panels and drawers. You can also select options that relate to drawers only.
For example, you can select an option to close your drawers when you click on a
launcher in the drawer.

You can also modify other properties for each individual drawer. You can change
features for each drawer, such as the visual appearance of the drawer and whether the
drawer has hide buttons.

To modify properties for a drawer perform the following steps:

1. Right-click on the drawer, then choose Properties to display the Panel Properties
dialog. The dialog displays the Drawer tabbed section.
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2. Select the properties for the drawer in the dialog. The following table describes the
elements on the Drawer tabbed section:

Dialog Element Description
Size Select the size of the drawer.
Tooltip/Name Use this text box to specify a name for the drawer. The name

appears as a tooltip when you point at the drawer on the panel.

Icon Choose an icon to represent the drawer. Click on the Icon
button to display an icon selector dialog. Choose an icon from
the dialog. Alternatively, click Browse to choose an icon from
another directory. When you choose an icon, click OK.

Enable hide button Select this option to display a hide button when the drawer
opens.

Enable hide button Select this option to display an arrow on the hide button if the

arrow hide button is enabled.

3. You can use the Background tabbed section to set the background for the drawer.
For information on how to complete the Background tabbed section, see the step
on this topic in “To Modify Panel Properties” on page 57. You can also drag a color
or image on to a drawer to set the color or image as the background of the drawer.
For more information, see “To Drag a Color or Image to the Background of a
Panel” on page 60.

4. Click Close to close the Panel Properties dialog.
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Log Out Button

The Log Out button begins the process to log out of a GNOME session.

To add a Log Out button to a panel, right-click on any vacant space on the panel.
Choose Add to Panel —Log Out Button. To log out of your session or shut down your
system, click on the Log Out button.

Lock Button

@

The Lock button locks your screen and activates your screensaver. To access your
session again, you must enter your password. To lock your screen correctly, you must
have a screensaver enabled.

To add a Lock button to a panel, right-click on any vacant space on the panel. Choose
Add to Panel —Lock Button.

Right-click on the Lock button to open a menu of screensaver-related commands.
Table 4-2 describes the commands that are available from the menu.
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TABLE 4-2 Lock Screen Menu Items

Menu ltem

Function

Activate Screensaver

Lock Screen

Kill Screensaver Daemon

Restart Screensaver Daemon

Properties

Activates the screensaver immediately, but does not
lock the screen.

Locks the screen immediately. This command
performs the same function as when you click on the
Lock button.

Terminates the screensaver process. After you
terminate the screensaver process, you cannot lock
your screen.

Terminates and restarts the screensaver process. Use
this command after you change your password.
When you restart the screensaver process, use your
new password with the screensaver.

Displays an XScreenSaver dialog that you can use to
configure the screensaver.

Screenshot Button

You can use the Screenshot button to take a screenshot of your desktop.

To add a Screenshot button to a panel, right-click on any vacant space on the panel.
Choose Add to Panel —Screenshot Button. To take a screenshot of your desktop, click

on the Screenshot button.
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Search Button
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You can use the Search button to open the Search Tool.

To add a Search button to a panel, right-click on any vacant space on the panel.
Choose Add to Panel —Search Button. To open the Search Tool, click on the Search
button.

For more information on the Search Tool, see the Search Tool Manual.

Run Button

3]

You can use the Run button to open the Run Program dialog.

To add a Run button to a panel, right-click on any vacant space on the panel. Choose
Add to Panel -Run Button. To open the Run Program dialog, click on the Run button.

For more information on the Run Program dialog, see Working With Menus.
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CHAPTER 5

Working With Menus

This chapter describes how to use menus in the desktop.

“Introduction to Menus” on page 77
“Menu Features” on page 78
“Applications Menu” on page 80
“Actions Menu” on page 80
“GNOME Menu” on page 83

Introduction to Menus

You can access all desktop functions through menus. The Menu Panel contains menus,
s0 you can use a combination of menus and panels to perform your tasks. You can
perform various actions on your menus, such as copy menu items to panels.

You can access the following menus from the desktop:

Applications menu: You can access many of your applications, commands, and
configuration options from the Applications menu. You can also access the desktop
preference tools from the Applications menu.

Actions menu: You can access various commands that enable you to perform
desktop tasks from the Actions menu. For example, you can start the Search Tool
application, or log out of the desktop.

GNOME Menu: You can also access the items in the Applications and Actions
menus from the GNOME Menu. You can have many GNOME Menu buttons in
your panels.

You can also right-click on the desktop background to open the Desktop Background
menu. The Desktop Background menu enables you to perform desktop
background-related tasks.
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All of these menus provide you with multiple ways to perform your tasks, and enable
you to work in the way that you prefer.

78

Menu Features

Menus can contain the following items:

®  Submenus
m  Launchers or menu items

An arrow to the right of an item in a menu indicates that the item is a submenu. When
you point to the submenu, the submenu opens. You can choose items from the
submenu.

When you choose a launcher, the launcher starts an application or runs a command.
You can also right-click on a launcher to open a popup menu. The popup menu
enables you to add the item to a panel, and perform other tasks. For more information
on the popup menu, see the next section.

You can change the theme for your session to change how all your menus look. To
change the theme, choose Applications — Desktop Preferences — Theme.

Menu Item Popup Menu

Items in menus have an associated popup menu that enables you to perform tasks
related to the item. When you right-click on an item in a menu, the popup menu for
the item opens. The popup menu also contains a submenu that allows you to perform
menu-related tasks.

You can use the menu item popup menu to perform the following tasks:

®  Add menu items as launchers to panels.

®  Remove items from menus.

®  Open the Run Program dialog with the menu item command in the dialog.

®  Add menus to panels. You can add a menu as a menu object or as a drawer object.
®  Add new items to menus.

m  Change the properties of submenus and menu items.

Figure 5-1 shows the popup menu.
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FIGURE 5-1 Menu Item Popup Menu

Table 5-1 describes menu item popup menus.

TABLE 5-1 Menu Item Popup Menus

Item

Description

Add this launcher to panel

Remove this item

Put into run dialog

Help on application_name

Properties

Entire menu — Add this as drawer to
panel

Entire menu — Add this as menu to
panel

Entire menu — Add new item to this
menu

Entire menu — Properties

Adds the launcher to the panel from which you open

the menu.

Removes the launcher from the menu.

Displays the Run Program dialog with the command

from the Command field of the launcher in the
command field on the Run Program dialog.

Opens the online help for the application.

Displays a dialog that enables you to edit the
properties of the launcher.

Adds the submenu as a drawer to the panel from
which you open the menu.

Adds the submenu as a menu object to the panel
from which you open the menu.

Enables you to add an item to the submenu.

Displays a dialog that enables you to edit the
properties of the submenu.
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Applications Menu

The Applications menu contains a hierarchy of submenus, from which you can start
the standard GNOME applications and preference tools. The Applications menu
contains the Desktop Preferences menu. You can use the Desktop Preferences menu to
start the desktop preference tools. The Applications menu also includes the file
manager and the help browser.

The Applications menu resides in the following places:

®  Menu Panel
m  Start Here location in Nautilus
®  GNOME Menu

Actions Menu

The Actions menu contains various commands that enable you to perform desktop
tasks. Table 5-2 describes the commands in the Actions menu.

TABLE 5-2 Actions Menu Commands

Menu Iltem Function

Run Program Opens the Run Program dialog. Use the Run Program
dialog to run commands. For more information, see
“Using the Run Program Dialog” on page 81.

Search for Files Starts the Search Tool application. For more information,
see the Search Tool manual.

Open Recent Displays a submenu of the last ten files which you saved.

Screenshot Takes a screenshot of the desktop, and opens the
Screenshot dialog. Use the Screenshot dialog to save the
screenshot.

Lock Screen Locks your screen.

Log Out Logs you out of the current session.

The Actions menu resides in the following places:

®  Menu Panel.

®  GNOME Menu. The items in the Actions menu are at the top level of the GNOME
Menu.
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Using the Run Program Dialog

The Run Program dialog gives you access to the command line. When you run a
command in the Run Program dialog, you cannot receive output from the command.

To run a command from the command line perform the following steps:

1. Display the Run Program dialog. You can display the Run Program dialog in any

of the following ways:

®  From the Menu Panel
Choose Actions — Run Program.
®  From the GNOME Menu

Open the GNOME Menu, then choose Run Program.

m  Use shortcut keys

The default shortcut keys to display the Run Program dialog are Alt + F2. You
can change the shortcut keys that display the Run Program dialog in the
Keyboard Shortcuts preference tool. To change the shortcut keys, choose
Applications — Desktop Preferences — Keyboard Shortcuts.

®  From a menu item popup menu

Right-click on an item in a menu, then choose Put into run dialog from the
popup menu. The Run Program dialog opens with the command from the
menu in the command field. The Run Program dialog is displayed.

Run Program

S

=~ Known Applications

% [T Run in terminal Append File..

=l

@ Audio Control
ﬁ Background
&) CD Database

Mo application selected

@ﬂelp ‘ X cancel

2. Enter the command that you want to run in the blank field. Alternatively, to choose a
command that you ran previously, click the down arrow button beside the command

field, then choose the command to run.

Alternatively, click on the Known Applications button to display a list of available

applications.

You can also use the Append File button to choose a file to append to the command
line. For example, you can enter emacs as the command, then choose a file to edit.
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Select the Run in terminal option to run the application or command in a terminal
window. Choose this option for an application or command that does not create a
window in which to run.

3. Click on the Run button on the Run Program dialog.

To Take a Screenshot

You can take a screenshot in any of the following ways:

m  Use the Actions menu

To take a screenshot of the entire screen, choose Actions — Screenshot. A
Screenshot dialog is displayed. To save the screenshot, select the Save screenshot
to file option. Enter the path and filename for the screenshot in the drop-down
combination box. Alternatively, to save the screenshot to another directory, click
Browse. When you select a directory, click OK.

You can also save the screenshot to the desktop background. To save the screenshot
to the desktop background, select the Save screenshot to desktop option.

m  Use shortcut keys

To take a screenshot, use the following shortcut keys:

Default Shortcut Keys Function

Print Screen Takes a screenshot of the entire screen, and displays the
Screenshot dialog. Use the Screenshot dialog to save the
screenshot.

Alt + Print Screen Takes a screenshot of the window that has focus, and

displays the Screenshot dialog. Use the Screenshot
dialog to save the screenshot.

You can use the Keyboard Shortcuts preference tool to modify the default shortcut
keys.

m  Use a command

You can use the gnome -panel-screenshot command to take a screenshot. The
gnome-panel -screenshot command takes a screenshot of the entire screen, and
displays the Screenshot dialog. Use the Screenshot dialog to save the screenshot.

You can also use options on the gnome-panel-screenshot command as
follows:
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GNOME Menu

Option

Function

--window

- -delay=seconds

--help

Takes a screenshot of the window that has focus, and
displays the Screenshot dialog. Use the Screenshot
dialog to save the screenshot.

Takes a screenshot after the specified number of seconds,

and displays the Screenshot dialog. Use the Screenshot

dialog to save the screenshot.

Displays the options for the command.

'é' Applications *
{3 CDE Menu i
I;j Run Prograrm.
o Search fer Files...
@ screenshot...
B Log Out

You can access almost all of the standard applications, commands, and configuration

options from the GNOME Menu.

The GNOME Menu provides the following top-level menus and special menu items:

Applications: Contains all applications and preference tools. This menu also
includes the file manager and the help browser.

Actions: Contains commands that enable you to perform desktop tasks, for
example the Lock Screen and Log Out commands. The items in the Actions menu
are at the top level of the GNOME Menu.

You can add GNOME Menu buttons to your panels. By default, the GNOME Menu is
represented on panels by a stylized footprint icon, as follows:
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To Open the GNOME Menu

You can open the GNOME Menu in the following ways:

®  From a panel with a GNOME Menu
Click on the GNOME Menu.
m  Use shortcut keys

You can use shortcut keys to open the GNOME Menu. When you use shortcut keys
to open the GNOME Menu, the GNOME Menu appears at the mouse pointer.

The default shortcut keys to open the GNOME Menu are Alt + F1. To change the
shortcut keys that open the GNOME Menu, choose Applications — Desktop
Preferences — Keyboard Shortcuts.

To Add a GNOME Menu to a Panel

You can add as many GNOME Menu buttons as you want to your panels. To add a
GNOME Menu to a panel, right-click on any vacant space on the panel. Choose Add
to Panel - GNOME Menu.

Customizing Your Menus

You can modify the contents of the following menus:

m  Applications menu
m  Desktop Preferences menu

You use the following desktop components to customize menus:

®  Menus on panels
®  Nautilus file manager

When you use panels to customize your menus, you use the menu item popup menu.
For more information, see “Menu Item Popup Menu” on page 78.
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When you use Nautilus to customize your menus, you must access the Applications
menu or the Desktop Preferences menu from within Nautilus. To access the
Applications menu or the Desktop Preferences menu, open a Nautilus window.
Choose Go — Start Here. Double-click on the Applications object or on the Desktop
Preferences object. For more information on Nautilus, see Nautilus File Manager.

To Add a Menu

To add a menu, perform the following steps:

1. In a Nautilus window, access the location where you want to add the menu. For
example, to add a menu to the Applications menu, choose Go — Start Here, then
double-click on the Applications object.

2. Choose File — New Folder. An untitled folder is added to the view pane. The name

of the folder is selected.

3. Type a name for the folder, then press Return.

The next time that you log out then log in again, the menu is in the assigned location.

To Add a Launcher to a Menu

To add a launcher to a menu, perform the following steps:

1. Right-click on any item in the menu to which you want to add the launcher.

2. Choose Entire menu — Add new item to this menu. A Create Launcher dialog is
displayed.

3. Enter the properties of the launcher in the Create Launcher dialog. For more
information on the elements in the Create Launcher dialog, see Working With
Panels.

4. Click OK.

To Add a Launcher to an Empty Menu

To add a launcher to an empty menu, perform the following steps:

1. Open a Nautilus window, then choose Go — Start Here. Alternatively, double-click

on the Start Here object on the desktop background. The Start Here location is
displayed.

2. In the Nautilus window, double-click on the object that represents the menu to
which you want to add the launcher.

3. Choose File - New Launcher. A Create Launcher dialog is displayed.

4. Enter the properties of the launcher in the Create Launcher dialog. For more
information on the elements in the Create Launcher dialog, see Working With
Panels.
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5.

Click OK.

To Copy a Launcher to a Menu

To copy an existing launcher to a menu, perform the following steps:

1.

In a Nautilus window, access the location from which you want to copy the
launcher. For example, to copy a launcher from the Applications menu, choose Go
— Start Here, then double-click on the Applications object.

2. Select the launcher that you want to copy, then choose Edit — Copy File.

3. In a Nautilus window, access the location to which you want to copy the launcher.

4. Choose Edit — Paste Files. The launcher is added to the new location.

Alternatively, you can drag the launcher from one location to another.

The next time that you log out then log in again, the launcher is in the new menu
location.

To Edit the Properties of a Menu

To edit the properties of a menu, perform the following steps:

1.
2.
3.

Right-click on any item in the menu that you want to edit.
Choose Entire menu — Properties. A Launcher Properties dialog is displayed.

Modify the properties of the menu in the Launcher Properties dialog. For more
information on the elements in the Launcher Properties dialog, see Working With
Panels.

Click OK.

To Edit a Menu Item

To edit a menu item, perform the following steps:

1.
2.
3.

Right-click on the item that you want to edit.
Choose Properties. A Launcher Properties dialog is displayed.

Modify the properties of the launcher in the Launcher Properties dialog. For more
information on the elements in the Launcher Properties dialog, see Working With
Panels.

Click OK.
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To Delete an Item from a Menu

To delete an item from a menu, use the menu item popup menu. To delete an item
from a menu, perform the following steps:

1. Right-click on the item that you want to delete.
2. Choose Remove this item.

Chapter 5 » Working With Menus 87



88 GNOME 2.2 Desktop User Guide * January 24, 2003



CHAPTER 6

Working With Windows

The information in this chapter describes how to use windows in the desktop. You can
use several types of window manager with the GNOME desktop, for example,
Metacity and Sawfish. Many of the functions in Metacity are also available in Sawfish.
This chapter describes the functions that are associated with the Metacity window
manager.

m  “Windows and Workspaces” on page 89
m  “Types of Window” on page 90
m  “Menus and Applets for Working With Windows and Workspaces” on page 94
®  “Manipulating Windows” on page 98
m  “Manipulating Workspaces” on page 102
|

Windows and Workspaces

You can display many windows at the same time on your desktop. Your windows are
displayed in subdivisions of your desktop that are called workspaces. A workspace is
a discrete area on the desktop in which you can work. Every workspace on the
desktop contains the same desktop background, the same panels, and the same
menus. However, you can run different applications, and open different windows in
each workspace. You can display only one workspace at a time on your desktop but
you can have windows open in other workspaces.

The Workspace Switcher applet displays a visual representation of your windows and
workspaces, as show in Figure 6-1.
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FIGURE 6-1 Workspace Switcher Applet

You can add workspaces at any time. To add workspaces to your desktop, right-click
on the Workspace Switcher applet, then choose Preferences. The Workspace Switcher
Preferences dialog is displayed. Use the Number of workspaces spin box to specify
the number of workspaces you require.

Window Manager Behavior

A window manager controls how windows appear and behave. The window manager
manages where your windows are located, which window has focus, and the theme of
the frame on the windows. The window frame contains buttons that enable you to
perform standard actions such as moving, closing, and resizing windows.

You can configure some window manager settings in the Window Focus preference
tool. This manual describes the functions that are associated with the default
configuration of the Metacity window manager. The default configuration is specified
in the Window Focus preference tool. This manual also describes the default functions
of the Crux theme.
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Types of Window

The desktop features the following types of windows:

m  Application windows

When you start an application, an application window opens. The window
manager applies a frame to the application window. By default, the top edge of the
application window contains a titlebar. The titlebar contains buttons that you can
use to work with the window. The buttons in an application window frame enable
you to perform actions such as open the Window Menu, or close the window. The
Window Menu provides a number of actions that you can perform on the window.

The following figure shows a typical application window.
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®  Dialog windows

A dialog window is a popup window in which you enter information or
commands. The dialog appears within a window frame.

You can use the top edge of the frame to work with the window. For example, you
can use the titlebar to move the dialog. The frame also contains buttons that enable
you to do the following:

®  Open the Window Menu
®  (Close the dialog window

Typically, you open a dialog window from an application window. When you open
a dialog window, the window is usually raised and has focus. Some dialog
windows do not allow you to use the application until you close the dialog.

The following figure shows a typical dialog window.
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Window Frames

A window frame is a border around a window. The window frame contains a titlebar.
The titlebar contains buttons that you can use to work with the window.

Themes

You can apply several themes to your window frames. The theme determines how the
frame looks. To choose a theme for all your window frames, choose Applications —
Desktop Preferences — Theme.

The default theme is Crux. This manual describes the functions that are associated
with the Crux theme.

Control Elements

You can use the window frame to perform various actions with the window. In
particular, the titlebar contains various buttons. The following figure shows the
titlebar of an application window:

Window Manu Close Window
button Titlebar button

| | |
.. AIEE]
Minimize Maximize
button button

Dialog windows also contain some of the window frame control elements. Table 6-1
describes the active control elements on window frames, from left to right.
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TABLE 6-1 Window Frame Control Elements

Control Element

Description

Window Menu button

Titlebar

Minimize button

Maximize button

Close Window button

Border

Window contents

Click on the button to open the Window Menu.

You can use the titlebar to perform the following

actions:

m  To give focus to the window click on the titlebar.

®  To move the window grab the titlebar and drag the
window to the new location.

®  To shade the window, double-click on the titlebar.
To unshade the window, double-click on the
titlebar again.

Click on the Minimize button to minimize the
window.

Click on the Maximize button to maximize the
window.

Click on the Close Window button to close the
window.

The border around the window. Use the border to

perform the following actions:

®  To resize the window grab the border and drag the
border to the new size.

B To open the Window Menu, right-click on the
border.

The area inside the window frame. Use the window

contents to perform the following actions:

®  To move a window, press-and-hold Alt, click in the
window contents, then drag the window to the
new location.

®  To resize a window, press-and-hold Alt, then
middle-click near the corner you want to resize. To
resize the window, drag from the corner on which
you middle-clicked.

®  To open the Window Menu, press-and-hold Alt,
then right-click in the window contents.
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Menus and Applets for Working With
Windows and Workspaces

This section describes the menus and applets that you can use to work with windows
and workspaces.

Window Menu

- Minirmize

B Maximize
Shade
Movwe
Besize

» Close
Futon All Waorkspaces
Maove to Workspace 1
Mawve to Workspace 2
Maowve to Workspace 3
ave to Warkspace 4

The Window Menu is a menu of commands that you can use to perform actions on
your windows. To open the Window Menu perform one of the following actions:

m  Click on the Window Menu button on the window that you want to work with.
m  Press Alt + spacebar.

®  Press-and-hold Alt, then right-click on any part of the window that you want to
work with.

Table 6-2 describes the commands and submenus in the Window Menu.

TABLE 6-2 Window Menu Commands and Submenus

Menu Item Function
Minimize Minimizes the window.
Maximize or Unmaximize Maximizes the window. If the window is already maximized,

choose Unmaximize to restore the window to its previous size.

Roll Up or Unroll Shades the window. If the window is already shaded, choose
Unroll to restore the window to its previous size.

Move Enables you to use the arrow keys to move the window.
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TABLE 6-2 Window Menu Commands and Submenus (Continued)

Menu item Function

Resize Enables you to use the arrow keys to resize the window.

Close Closes the window.

Put on All Workspaces or Puts the window on all of your workspaces. If the window is

Only on This Workspace already on all of your workspaces, choose Only on This
Workspace to put the window on the current workspace only.

Move to workspace_name or Moves the window to the workspace that you choose. If the

Only on workspace_name window is on all of your workspaces, choose Only on
workspace_name to put the window on the workspace that you
want.

Window List Applet

Window List displays a button for each application window that is open. You can use
the Window List to perform the following tasks:

®  To minimize a window

Click on the button that represents the window.
m  To restore a minimized window

Click on the button that represents the window.
m  To give focus to a window

Click on the button that represents the window.

When you open an application window, Window List displays a button that
represents the window. The window list buttons show which application windows are
open. You can view which windows are open even if some windows are minimized,
or other windows overlap a window. Window List can display buttons for the
windows in your current workspace, or in all workspaces. To select this option, you
must change the preferences of Window List.

You can also right-click on a window list button to open the Window Menu for the
window that the button represents. When you open the Window Menu from Window
List, the Window Menu does not contain the workspace commands. For more
information on the Window Menu commands, see “Window Menu” on page 94.

Figure 6-2 shows Window List when the following windows are open:

gedit

Dictionary

GHex

GNOME Terminal
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L. gedi > [Dictionany -1 b | | ] Grome—terminal (3)

FIGURE 6-2 Window List Applet

The buttons in the applet show the status of your windows. Table 6-3 explains the
information that the window list buttons provide about the window. The examples in
Table 6-3 refer to Figure 6-2.

TABLE 6-3 Window Status Information on Window List Buttons

State Indicates Example

Button is pressed in. The window has focus. gedit

Square brackets around The window is minimized. [Dictionary]
window title.

Button is not pressed in, no The window is displayed, and ghex

square brackets around title.  is not minimized.

Numeral on button, in The button represents a group Gnome-terminal (3)
parentheses. of buttons.

Grouping Buttons

Window List can group the buttons that represent windows in the same class under
one window list button. The Gnome-terminal button in Figure 6-2 is an example of a
button that represents a group of buttons. The following figure shows an example of
Window List with a button group open:

B Horre Directony
B Project Directary
B Mail Directony

L. gedi > [Dictionany -1 b ||_1 Gnome-terminal (3

To open a list of the windows in a group, click on the window list button that
represents the group. You can click on the items in the list to give focus to windows,
minimize windows, and restore windows.

To open the Window Menu for a window in a button group, right-click on the window
list button that represents the group. A list of the windows in the group is displayed.
To open the Window Menu for a window in the group, click on the item in the list.
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When you open the Window Menu from the Window List, the Window Menu does
not contain the workspace commands. For more information on the Window Menu
commands, see “Window Menu” on page 94.

Workspace Switcher Applet

Workspace Switcher displays a visual representation of your workspaces, as shown in
Figure 6-3. Figure 6-3 shows the applet when the GNOME session contains four
workspaces. Your workspaces appear as buttons on the applet. The background of the
button in the applet that represents the current workspace is highlighted. The current
workspace in Figure 6-3 is the workspace at the left of the applet. To switch to another
workspace, click on the workspace in the applet.

[t 5

FIGURE 6-3 Workspace Switcher Applet

Workspace Switcher also displays the application windows and dialogs that are open
in your workspaces.

The applet displays the workspaces in order from left to right across the rows of the
applet. In Figure 6-3, the applet is set up to display the workspaces in one row. You
can specify the number of rows in which your workspaces are displayed in Workspace
Switcher. You can also change the default behavior of the applet to display the names
of your workspaces in the applet.

Using the Menu Panel to Work With Windows

From the Menu Panel, you can view a list of all windows that are currently open. You
can also choose a window to give focus to. To view the window list, click on the icon
at the extreme right of the Menu Panel. The following figure shows an example of the
window list that is displayed from the Menu Panel:
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When the focus changes, the icon that you click on to display the window list changes.
The icon represents the window that currently has focus. To give focus to a window,
choose that window from the window list.

The window list lists the windows in all workspaces. The windows in all workspaces
other than the current workspace, are listed under a separator line.

You cannot move the icon at the extreme right of the Menu Panel.
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Manipulating Windows

This section describes how to manipulate windows.

To Give Focus to a Window

A window that has focus can receive input from the mouse and the keyboard. Only
one window can have focus at a time. The window that has focus has a different
appearance than other windows.

You can use the following elements to give focus to a window:

Element Action
Mouse Click on the window, if the window is visible.
Shortcut keys Use shortcut keys to switch between the windows that are

open. To give focus to a window, release the keys. The default
shortcut keys to switch between windows are Alt + Tab.
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Element Action

Window List Click on the button that represents the window in Window
List.
Workspace Switcher Click on the window that you want to give focus to in the

Workspace Switcher display. If you click on a window in
another workspace, Workspace Switcher switches to the new
workspace, and gives focus to the window.

Menu Panel Click on the icon at the extreme right of the Menu Panel. A list

of your open windows is displayed. Choose the window from
the list.

To Minimize a Window

To minimize a window perform one of the following actions:

Click on the Minimize button on the window frame.
Open the Window Menu, then choose Minimize.

If the window has focus, click on the button that represents the window in
Window List. If the window does not have focus, click twice on the button that
represents the window.

Right-click on the button that represents the window in Window List, then choose
Minimize from the popup menu.

To Maximize a Window

When you maximize a window, the window expands as much as possible. To
maximize a window perform one of the following actions:

To maximize the window, click on the Maximize button on the window frame.
Alternatively, open the Window Menu, then choose Maximize.

Right-click on the button that represents the window in Window List, then choose
Maximize from the Window Menu.

To Restore a Window

To restore a maximized window perform one of the following actions:

Click on the Maximize button on the window frame.
Open the Window Menu. Choose Unmaximize.

Right-click on the button that represents the window in Window List to open the
Window Menu. Choose Unmaximize.
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To restore a minimized window, click on the button that represents the window in
Window List.

To Close a Window

To close a window perform one of the following actions:

m  (Click on the Close Window button on the window frame.
®m  Open the Window Menu. Choose Close.

m  Right-click on the button that represents the window in Window List, then choose
Close from the Window Menu.

If you have unsaved data in the window, you are prompted to save your data.

To Resize a Window

To resize a window perform one of the following actions:

®  Point to a corner of the window. The mouse pointer changes to indicate that you
can resize the window. Grab the corner and drag the window to the new size.

m  Right-click on the button that represents the window in Window List. Choose
Resize from the Window Menu. Use the arrow keys to resize the window.

m  Press-and-hold Alt, then middle-click near the corner that you want to resize. The
mouse pointer changes to indicate that you can resize from the corner. To resize the
window, drag from the corner on which you middle-clicked.

®  To resize a window horizontally point to one of the vertical edges of the window.
The mouse pointer changes to indicate that you can resize the window. Grab the
edge and drag the window to the new size.

m  To resize a window vertically point to the bottom edge of the window. The mouse
pointer changes to indicate that you can resize the window. Grab the edge and
drag the window to the new size.

Note — You cannot resize some dialog windows. Also, some application windows have
a minimum size below which you cannot reduce the window.

To Move a Window

To move a window perform one of the following actions:

m  Grab the titlebar of the window and drag the window to the new location.

®  Press-and-hold Alt, then drag the window to the new location.
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®  Open the Window Menu, then choose Move. Use the arrow keys to move the
window to the new location.

m  Right-click on the button that represents the window in Window List, then choose
Move from the Window Menu. Use the arrow keys to move the window to the new
location.

To Shade a Window

You can shade and unshade windows, as follows:

Shade Reduce the window so that only the titlebar is visible.
Unshade Switch a window from a shaded state so that the full window is
displayed.

To shade a window perform one of the following actions:

m  Double-click on the titlebar of the window. To unshade the window, double-click
on the titlebar again.

®  Open the Window Menu. Choose Roll Up. To unshade the window, choose Unroll.

m  Right-click on the button that represents the window in Window List, then choose
Roll Up from the Window Menu. To unshade the window, choose Unroll.

To Put a Window on All Workspaces

To put a window in all workspaces, open the Window Menu. Choose Put on All
Workspaces. To set the window to appear only in the current workspace, choose Only
on This Workspace.

To Move a Window to Another Workspace

You can move a window to another workspace in either of the following ways:
m  Use Workspace Switcher

In the Workspace Switcher display, drag the window to the workspace you require.
m  Use the Window Menu

Open the Window Menu. To move the window to the next workspace choose
Move to workspace_name.
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Manipulating Workspaces

This section describes how to manipulate workspaces.

To Switch Between Workspaces

You can switch between workspaces in any of the following ways:
m  Use Workspace Switcher

Click on the workspace that you want to switch to in Workspace Switcher.
m  Use shortcut keys

The default shortcut keys to switch between the workspaces are as follows:

Default Shortcut Keys Function
Ctrl + Alt + right arrow Selects the workspace to the right.
Ctrl + Alt + left arrow Selects the workspace to the left.

To Add Workspaces

To add workspaces to your desktop, right-click on Workspace Switcher, then choose
Preferences. The Workspace Switcher Preferences dialog is displayed. Use the
Number of workspaces spin box to specify the number of workspaces you require.
Workspace Switcher adds new workspaces at the end of the workspace list.

To Name Workspaces

The default names of your workspaces are Workspace 1, Workspace 2, Workspace
3, and so on. To assign names to your workspaces, right-click on Workspace Switcher,
then choose Preferences. The Workspace Switcher Preferences dialog is displayed.
Use the Workspaces list box to specify the names of your workspaces. Select a
workspace, then type the new name for the workspace.

To Delete Workspaces

When you delete a workspace the windows in the workspace are moved to another
workspace, and the empty workspace is deleted.
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To delete workspaces from your desktop, right-click on Workspace Switcher, then
choose Preferences. The Workspace Switcher Preferences dialog is displayed. Use the
Number of workspaces spin box to specify the number of workspaces you require.
Workspace Switcher deletes workspaces from the end of the workspace list.
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CHAPTER 7

Nautilus File Manager

This chapter describes how to use the Nautilus file manager.

“Introduction to Nautilus File Manager” on page 105
“Nautilus Windows” on page 106

“Navigating Your Computer” on page 112

“Managing Your Files and Folders” on page 120

“Running Scripts From Nautilus” on page 126

“Modifying the Appearance of Files and Folders” on page 127
“Assigning Actions to Files” on page 134

“Customizing Nautilus” on page 135

“Using Removable Media” on page 144

Introduction to Nautilus File Manager

The Nautilus file manager provides an integrated access point to your files and
applications. Nautilus enables you to do the following:

m  Display your files and folders.

®  Manage your files and folders.

®  Run scripts.

m  Customize your files and folders.

Nautilus also manages the desktop background. The desktop background lies behind
all of the other components on your visible desktop. The desktop background is an
active component of the user interface.

Nautilus windows enable you to display and manage your files and folders. You can
open a Nautilus window in any of the following ways:

®  Double-click on the Home object on the desktop background.

®  Choose Applications — Home Folder.

105



m  Right-click on the desktop background to open the Desktop Background menu.
Choose New Window.

The Nautilus window displays the contents of your home location in the view pane.

Nautilus Windows

Nautilus windows enable you to display and manage your files and folders. Figure
7-1 shows a Nautilus window that displays the contents of a folder.
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FIGURE 7-1 Contents of a Folder in a Nautilus Window
Table 7-1 describes the components of Nautilus windows.
TABLE 7-1 Nautilus Window Components

Component Description

Menubar Contains menus that you use to perform tasks in Nautilus.
Toolbar Contains buttons that you use to perform tasks in Nautilus.
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TABLE 7-1 Nautilus Window Components (Continued)

Component Description

Location bar Contains the following elements:
B Location field or Go To field: Enables you to specify a file,
folder, or URL that you want to display.
B Zoom buttons: Enable you to change the size of items in the
view pane.
B View as drop-down list box: Enables you to choose how to
display items in your view pane.

Side pane Performs the following functions:
B Enables you to navigate through your files.
®  Displays information about the current file or folder.

The side pane contains a drop-down list box that enables you to
choose what to display in the side pane. You can choose from the
following options:

B Information

®  Emblems
®  History
= Notes
B Tree
View pane Displays the contents of the following:
®  Particular types of files
®  Folders
®m  FTP sites
Resize handle Grab this handle, then drag to resize the side pane and the view
pane.
Statusbar Displays status information.

You can also open a popup menu from Nautilus windows. To open this popup menu
right-click in a Nautilus window. The items in this menu depend on where you
right-click. For example, when you right-click on a file or folder, you can choose items
related to the file or folder. When you right-click on the background of a view pane,
you can choose items related to the display of items in the view pane.

View Pane

The view pane can display the contents of the following;:

m  Particular types of files
m  Folders
m  FTP sites
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Nautilus contains viewer components that enable you to display particular types of file
in the view pane. For example, you can use an image viewer to display Portable
Network Graphics (PNG) files in the view pane. The following figure shows a PNG
file displayed in the view pane.
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Displaying a file in the view pane provides the following benefits:

m  Uses less system resources than when you launch an application.
m  Takes less time than when you launch an application.

However, you cannot edit a file in the view pane.

Nautilus also includes views that enable you to display the contents of your folders in
different ways. For example, you can display the contents of a folder in the following
types of view:

®  Jcon view: Displays the items in the folder as icons.
m  List view: Displays the items in the folder as a list.

Use the View menu to choose how to display a folder. For more information on views,
see “Using Views to Display Your Files and Folders” on page 129.

Side Pane

You can choose what information you want to view in the side pane. You can choose
to display one of the following;:
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®  Information

Displays an icon that represents the current file or current folder. Also displays
information about the current file or current folder. If a file is displayed in the view
pane, buttons appear in the side pane. The buttons enable you to perform actions
on a file, other than the default action.

®=  Emblems

Contains emblems that you can add to a file or folder. For more information on
emblems, see the next section.

= History

Contains a history list of files, folders, and FTP sites that you have recently visited.
®  Notes

Enables you to add notes to your folders.
m Tree

Displays a hierarchical representation of your file system. You can use the Tree to

navigate through your files.

To close the side pane, click on the X button at the top right of the side pane.

Icons and Emblems

In icon view, Nautilus displays your files and folders as icons. You can add emblems
to your file icons and folder icons. An emblem is a small icon that you can add to an

item to visually mark the item. For example, to mark a file as important, you can add
an Important emblem to the file icon to create the following visual effect:

Laorem ig
Lorem ig

Lorem ic

loremipsum.txt
27K

For more information on how to add an emblem to an icon, see “To Add an Emblem
to a File or Folder” on page 127.

The following table describes the structure of the file icon:
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Component Description

0

Emblem. This emblem is the Important emblem.

Icon that represents the file. This icon contains a preview of
the contents of the file.

Lorem ig
Lorem ig
Lorem ic
Icon caption. You can modify what items of information are
loremipsum.txt displayed in the icon caption.
27K

Nautilus includes default emblems for the following types of item:

®  Symbolic links
®  Jtems for which you have the following permissions:
®m  Read permission only

®  No read permission and no write permission

The default emblems change depending on your theme. The following table shows the
default emblems for the Default theme.

Default Emblem Description

Symbolic link

»

Read permission only

8

No read permission and no write permission
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Navigating Your Computer

Each Nautilus window displays the contents of a single file, folder, or FTP site. This
section describes the following:

How to display items in Nautilus windows.

How to open files from Nautilus windows.

How to navigate the files and folders in your file system.
How to navigate to FTP sites.

To Display Your Home Location

o

useri?3's Home

To display your home location, perform one of the following actions:

®  Double-click on the Home object on the desktop background.
®  On a Nautilus window, choose Go — Home.
®  On a Nautilus window, click on the Home toolbar button.

The Nautilus window displays the contents of your home location. To reload the
display, click on the Reload button.

To Display a Folder

You can display the contents of a folder in any of the following ways:

m  Double-click on the folder in the view pane.

®  In the Location field, type the path of the folder that you want to display, then
press Return. The Location field includes an autocomplete feature. As you type a
path, Nautilus reads your file system. When you type enough characters to
uniquely identify a directory, Nautilus completes the name of the directory in the
Location field.

m  Use the Tree in the side pane. For more information, see “Using the Tree From the
Side Pane” on page 113.

m  Use the Back toolbar button and the Forward toolbar button to browse through
your navigation history.
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To change to the folder that is one level above the current folder, choose Go — Up.
Alternatively, click on the Up toolbar button.

To reload the display, click on the Reload button.

If you cannot find the folder that you want to display, you can use Search Tool. To start
Search Tool, choose Actions — Search for Files.

Using the Tree From the Side Pane

The Tree displays a hierarchical representation of your file system. The Tree provides a
convenient way to navigate your file system. To display the Tree in the side pane,
choose Tree from the drop-down list box at the top of the side pane.

The following figure shows the Tree.
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In the Tree, folders are represented as follows:

Folder State Graphic Representation
Closed folder Right arrow
Open folder Down arrow

Table 7-2 describes the tasks that you can perform with the Tree, and how to perform
the tasks.
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TABLE 7-2 Tree Tasks

Task Action

Open the Tree. Choose Tree from the drop-down list box at
the top of the side pane.

Close the Tree. Choose another item from the drop-down list
box at the top of the side pane.

Open a folder in the Tree. Click on the arrow next to the folder in the
Tree.

Close a folder in the Tree. Click on the arrow next to the folder in the
Tree.

Display the contents of a folder in the view Select the folder in the Tree.

pane.

Display the contents of a file in the view pane. Select the file in the Tree.

You can set your preferences so that the Tree does not display files. For more
information, see “To Set Views Preferences” on page 136.

Opening Files
When you open a file, Nautilus performs the default action for that file type. The

default action can be one of the following;:

m  Use a viewer component to display the file in the view pane.
®  Launch an application that opens the file.

Nautilus checks the contents of a file to determine the type of a file. If the first lines do
not determine the type of the file, then Nautilus checks the file extension.

If you cannot find the file that you want to open, you can use Search Tool. To start
Search Tool, choose Actions — Search for Files.

Viewing Files in the View Pane

Nautilus contains viewer components that enable you to display particular types of
file in the view pane. For example, you can display the following types of files in the
view pane:

m  Plain text files
m  Portable Network Graphics (PNG) files
®  Joint Photographic Experts Group (JPEG) files

To reload the contents of the view pane, choose View — Reload. To stop loading an
item in the view pane, choose View — Stop.
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When you display a file in the view pane, the viewer component might add menu
items to the Nautilus menus. The menu items relate to the file type that is displayed.
For example, when you display a PNG file, the Edit menu contains flip and rotate
menu items.

Also, when you display some types of file in the view pane, you can use the Nautilus
zoom buttons to change the size of the item.

To Execute the Default Action

To execute the default action for a file, double-click on the file. For example, if the
default action for plain text documents is to display the file in a text viewer. In this
case, you can double-click on the file to display the file in a text viewer.

You can set your file manager preferences so that you click once on a file to execute the
default action. For more information, see “To Set File and Folder Preferences”
on page 137.

To Execute Non-Default Actions Using the Open With
Submenu
To execute actions other than the default action for a file, perform the following steps:

1. In the view pane, select the file that you want to perform an action on. Choose File
— Open With. The Open With submenu opens. The items in this submenu
correspond to the contents of the following parts of the File Types and Programs
preference tool:

®  Default action drop-down list box in the Edit file type dialog
®  Viewer component drop-down list box in the Edit file type dialog

2. Choose an action from the Open With submenu.

To Execute Other Actions When Displaying a File

When you display a file in the view pane, the side pane might contain buttons. Figure
7-2 shows the side pane when a text file is displayed in the view pane.
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Open with gedit
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Open with KEmacs
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FIGURE 7-2 Side Pane When a File is Displayed in the View Pane

The buttons represent any actions that are defined in the File Types and Programs
preference tool. The actions are defined in the Default action drop-down list box in
the Edit file type dialog in the File Types and Programs preference tool. Click on a
button to execute an action. For example, if an action defined for plain text documents
is to open the file in gedit. If this action is defined, an Open with gedit button is
displayed in the side pane. To open the file in the gedit application, click on the Open
with gedit button.

Note — A button that represents the action does not appear in the side pane if the
actions are excluded in either of the following dialogs:

®  Open with Other Application
= Open with Other Viewer

Using the Start Here Location
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Start Here

The Start Here location enables you to access the following functions:
m  Applications

Double-click on Applications to access your key GNOME applications. You can
also access the Applications menu through the GNOME Menu and the Menu
Panel.

m  Desktop Preferences

Double-click on Desktop Preferences to customize your desktop. You can also
access the desktop preferences through the Applications menu.

®  Programs that enable you to configure your system as a server, and to choose other
system settings.

You can access the Start Here location in the following ways:

®  From a Nautilus window

Choose Go — Start Here. The contents of the Start Here location are displayed in
the window.

®  From the desktop background

Double-click on the Start Here object on the desktop background. The contents of
the Start Here location are displayed in a Nautilus window.

To Access FTP Sites

You can use Nautilus to access FTP sites. To access an FTP site, enter the URL for the
site in the field on the location bar, then press Return. The contents of the site are
displayed in the view pane. To copy a file from the FTP site, drag the file to the new
location.

To access an FTP site that requires a username and password, you can enter the URL
in the following form:

ftp://username : password@hostname . domain

To reload the FIP site in the view pane, choose View — Reload. To stop loading the
FTP site, choose View — Stop.
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Using Your Navigation History

The file manager maintains a history list of files, folders, and FTP sites. You can use
the history list to navigate to files, folders, and FTP sites that you have recently visited.
The following sections describe how to navigate your history list.

To clear your history list choose Go — Clear History.

To Navigate Your History List Using the Go Menu

To display a list of previously-viewed items, choose the Go menu. Your history list is
displayed in the lower part of the Go menu. To open an item in your history list,
choose the item from the Go menu.

To Navigate Your History List Using the Toolbar
To use the toolbar to navigate your history list, perform one of the following actions:

m  To open the previous file, folder, or URL in your history list, click on the Back
toolbar button.

®  To open the next file, folder, or URL in your history list, click on the Forward
toolbar button.

= To display a list of previously-viewed items, click on the down arrow to the right
of the Back toolbar button. To open an item from this list, click on the item.

m  To display a list of items that you viewed after you viewed the current item, click
on the down arrow to the right of the Forward toolbar button. To open an item
from this list, click on the item.

To Navigate Your History List Using History in the Side
Pane

To display the History list in the side pane, choose History from the drop-down list
box at the top of the side pane. The History list in the side pane displays a list of your
previously-viewed items.
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To display an item from your history list in the view pane, click on the item in the
History list.

To Bookmark Your Favorite Locations

To access an item in your bookmarks, choose the item from the Bookmarks menu. You
can add your favorite locations to your Bookmarks menu. You can add bookmarks to
files and folders in your file system, or to FTP sites.

To Add a Bookmark

To add a bookmark, display the item that you want to bookmark in the view pane.
Choose Bookmarks — Add Bookmark.

To Edit a Bookmark

To edit your bookmarks perform the following steps:

1. Choose Bookmarks — Edit Bookmarks. An Edit Bookmarks dialog is displayed.

2. To edit a bookmark, select the bookmark on the left side of the Edit Bookmarks
dialog. Edit the details for the bookmark on the right side of the Edit Bookmarks
dialog, as follows:

Dialog Element Description

Name Use this text box to specify the name that identifies the bookmark
in the Bookmarks menu.

Location Use this field to specify the location of the bookmark.

3. To delete a bookmark, select the bookmark on the left side of the dialog. Click
Delete.
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Managing Your Files and Folders

This section describes how to work with your files and folders.

Drag-and-Drop in Nautilus

You can use drag-and-drop to perform several tasks in Nautilus. When you
drag-and-drop, the mouse pointer provides feedback about the task that you perform.
Table 7-3 describes the tasks that you can perform with drag-and-drop. The table also
shows the mouse pointers that appear when you drag-and-drop.

TABLE 7-3 Drag-and-Drop in Nautilus

Task Action Mouse Pointer

Move an item Drag the item to the new location.

N

Copy an item Grab the item, then press-and-hold Ctrl. Drag the item
to the new location. F
Link to an item Grab the item, then press-and-hold Ctrl + Shift. Drag
the item to the location where you want the link to E
reside.
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TABLE 7-3 Drag-and-Drop in Nautilus (Continued)

Task Action Mouse Pointer

Ask what to do Grab the item, then press-and-hold Alt. Drag the item
with the item you  to the location where you want the item to reside. 73
drag Release the mouse button. A popup menu appears. :
Choose one of the following items from the popup
menu:

Move here

Moves the item to the location.

Copy here

Copies the item to the location.

Link here

Creates a symbolic link to the item at the location.
Set as Background

If the item is an image, sets the image to be the
background wallpaper. You can use this command
to set the desktop background and the view pane
background.

Cancel

Cancels the drag-and-drop operation.

To Select Files

You can select files and
select items in Nautilus

TABLE 7-4 Selecting Items

and Folders

folders in several ways in Nautilus. Table 74 describes how to
windows and on the Nautilus desktop background.

in Nautilus

Task

Action

Select an item

Click on the item.

Select a group of contiguous In icon view, drag around the files that you want to select.

items

Select multiple items

Select all items in a folder

In list view, press-and-hold Shift. Click on the first item in
the group, then click on the last item in the group.

Press-and-hold Ctrl. Click on the items that you want to
select.

Alternatively, press-and-hold Ctrl, then drag around the
files that you want to select.

Choose Edit — Select All Files.

To perform the default action on an item, double-click on the item. You can set your
file manager preferences so that you click once on a file to execute the default action.

For more information, s

ee “To Set File and Folder Preferences” on page 137.
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To Move a File or Folder

The following sections describe the ways that you can move a file or folder.

Drag to the New Location in a View Pane
To drag a file or folder to a new location in a view pane, perform the following steps:

1. Open a Nautilus window. Choose File - New Window to open a second Nautilus
window.

2. In one window, select the folder from which you want to move the file or folder. In
the other window, select the folder to which you want to move the file or folder.

3. Drag the file or folder that you want to move to the new location in the other
window.

To move the file or folder to a folder that is one level below the current location, do
not open a new window. Instead, drag the file or folder to the new l